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Abstract 

Chess was for many years the main domain for Artificial Intelligence (AI) research. 
However, after the victory of Deep Blue over Gary Kasparov – world champion at the time – it 

was clear that new challenges and domains had to be considered. The scientific community 

searching for new and complex problems, found robotic soccer as a new domain for research in 
Distributed Artificial Intelligence. 

The robotic soccer, part of the RoboCup Initiative, is an attempt to foster AI and intelligent 

robotics research by providing a standard problem where a wide range of technologies can be 

integrated and examined. Because of the complexity of the environment and the need to work as a 
team to reach a common goal, the research for coordination methodologies is a key aspect, 

especially in simulated environments. 

To better deal with this diversity of challenges, robotic soccer has been split in different and 
heterogeneous leagues, but all of them sharing the need for coordination methodologies. This 

diversity allowed research teams to deal with a broad of scientific issues, however, it also brought 

some setbacks: the increased focus in league specific problems, overspecialization, neglecting the 
benefits from generalisation and wide application. Generic coordination methodologies that can 

be applied to different leagues, with the necessary adjustments, can speed up the team‟s 

development and improve its quality. Sharing a common framework, all coordination 

methodologies may be applied to distinct leagues and may be subject of continuous research and 
improvement. Although all robotic soccer simulation competitions were taken in account in this 

work, a special focus was given to the 2D soccer simulation competition since this is presently 

the competition that, due to its 11 against 11 games, demands for more advanced coordination 
methodologies. 

In the context of this work, a generic coordination model was implemented in the various 

leagues that the FC Portugal team participated in RoboCup 2010 Competition (2D, 3D and 
Mixed-Reality leagues). This model was based on the notions of tactics, formations, dynamic 

positioning and role exchange, game flow and an individual decision criterion when in possession 

of the ball which was based on the concepts of flux, safety and easiness. To allow the definition 

of advanced formations and game flow for the various leagues, a generic graphical tool was 
developed, based on previous work. All the necessary modules were successfully integrated in 

these three leagues and used during the RoboCup competition. 

The Triangulation based Positioning Mechanism, a function representation model to define 
a team formation, which uses Delaunay Triangulation and a linear interpolation algorithm, was 

extended in this work by considering special local formations depending on the ball owner. The 

performance tests of the new formation mechanism have shown promising results. Overall we can 

see an improvement of the team‟s performance, both in offence and defence, that seem to justify 
the use of the new positioning mechanism in future competitions. 
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Resumo 

O Xadrez foi durante muitos anos o principal domínio de investigação para a Inteligência 
Artificial (IA). No entanto, após a vitória do computador Deep Blue sobre Gary Kasparov – o 

campeão mundial na altura em título – foi claro que teriam de ser considerados novos desafios e 

domínios. A comunidade científica, à procura de novos e complexos problemas, encontrou o 
futebol robótico como um novo domínio de investigação para a Inteligência Artificial Distribuída. 

O futebol robótico, parte da iniciativa do RoboCup, é uma tentativa de estimular a 

investigação em IA e Robótica Inteligente e baseia-se na utilização de um problema standard 

onde um vasto número de tecnologias pode ser integradas e examinadas. Devido à complexidade 
do ambiente e à necessidade de trabalhar em equipa para alcançar um objectivo comum, a 

investigação em metodologias de coordenação é um aspecto essencial, especialmente em 

ambientes simulados. 
De modo a lidar melhor com a diversidade de desafios, o RoboCup foi dividido em várias 

ligas diferentes e heterogéneas, mas todas elas partilhando a necessidade de coordenação. Esta 

diversidade permitiu que as equipas de investigação lidassem com uma ampla gama de aspectos 
científicos, embora também tenha trazido alguns contratempos: um foco maior em problemas 

específicos de cada liga, especialização excessiva, negligenciando os benefícios da generalização 

e ampla aplicação. Metodologias de coordenação genéricas que possam ser aplicadas a diferentes 

ligas, com os necessários ajustes, podem reduzir o tempo de desenvolvimento de cada equipa e 
aumentar a sua qualidade. Partilhando uma base comum, todas as metodologias de coordenação 

poderão estar sujeitas a uma contínua investigação e melhoria. Apesar de todas as ligas robóticas 

de futebol terem sido tidas em conta neste trabalho, um foco especial foi dado à liga de simulação 
2D já que é a liga que actualmente, devido aos jogos 11 contra 11, necessita de metodologias de 

coordenação mais avançadas. 

No âmbito desta dissertação, um modelo genérico de coordenação foi implementado nas 
várias ligas em que a equipa FC Portugal participou no RoboCup 2010 (liga 2D, 3D e Mixed-

Reality). Este modelo foi baseado em noções de tácticas, formações, troca dinâmica de posições, 

fluxo de jogo e um critério de decisão individual quando na posse da bola que, por sua vez, foi 

baseado nos conceitos de fluxo, segurança e facilidade. Para permitir a definição de formações 
avançadas e fluxo de jogo para as várias ligas, foi desenvolvido uma ferramenta gráfica genérica, 

baseado em trabalho anterior. Todos os módulos necessários foram integrados com sucesso nestas 

três ligas e usados durante a competição. 
O mecanismo de posicionamento baseado em triangulação, um modelo representativo para 

definir a formação de uma equipa, utilizando a Triangulação de Delaunay e um algoritmo de 

interpolação linear, foi estendido neste trabalho considerando formações locais especiais 

dependendo do jogador com a posse da bola. Os testes conduzidos sob o novo sistema de 
posicionamento mostraram resultados promissores. No geral, o desempenho da equipa aumentou, 

quer no ataque, quer na defesa, o que parece justificar o uso do novo sistema de posicionamento 

em competições futuras.  



 

iv 

 



 

v 

Acknowledgements 

This work was possible due to the orientation, support and motivation of many people. For them I 
show my gratitude. 

 

I would like to thank my advisor and co-advisor, Luis Paulo Reis and Nuno Lau, specially the 
first, for the proposal of this thesis, for the opportunity that was given to me to work on this 

subject and for all the knowledge and experience shared and availability at every moment. 

 

Also to Luis Paulo Reis for the financial support that allowed the participation in the RoboCup 
competitions and to the Informatics Department (DEI) of the University of Porto, also for its 

contribution. 

 
To the FC Portugal team, namely Nima Shafii, Miguel Oliveira, Hugo Mendes, Luis Rei, Bruno 

Pimentel, Fernando Almeida, with a special thanks to Luís Mota, for the excellent companionship 

throughout this work and for the support and suggestions. 
 

To Rui Lopes for the initial help and guidance, which it helped starting on the right track and for 

that I am really appreciated. 

 
To Victor Oliveira and Lobão Adelino, for the excellent companionship during the Robotics 

course and for all the advices and suggestions. 

 
To João Portela for aiding me configuring the final tests, which was really helpful to take the 

right conclusions. 

 
And finally to my family and all of my friends that have been there for me during this work, for 

the support and motivation, I am really grateful. 

 

 
 

Filipe Marques 



 

vi 



 

vii 

Contents 

1 Introduction ..................................................................................................................... 1 
1.1 Context ........................................................................................................................ 1 
1.2 Agent and Multi-Agent System .................................................................................... 1 
1.3 Coordination in Multi-Agent System ............................................................................ 3 
1.4 FC Portugal .................................................................................................................. 3 
1.5 Motivation and Objectives............................................................................................ 3 
1.6 Thesis Outline .............................................................................................................. 4 

2 Team Level Coordination in RoboCup ........................................................................... 5 
2.1 RoboCup ...................................................................................................................... 5 

2.1.1 Objectives ............................................................................................................ 5 
2.1.2 History ................................................................................................................. 6 
2.1.3 Small-size League ................................................................................................ 7 
2.1.4 Middle-size League .............................................................................................. 7 
2.1.5 Standard Platform League..................................................................................... 8 
2.1.6 Humanoid League ................................................................................................ 9 
2.1.7 Simulation League ................................................................................................ 9 
2.1.8 Mixed-Reality League ........................................................................................ 10 

2.2 The 2D Simulation League ......................................................................................... 10 
2.2.1 Constitution of the System .................................................................................. 11 
2.2.2 Rules .................................................................................................................. 13 
2.2.3 Communication Protocol .................................................................................... 13 
2.2.4 Coach ................................................................................................................. 16 
2.2.5 Motivation and Challenges ................................................................................. 17 

2.3 Coordination of Cooperative Agents ........................................................................... 17 
2.3.1 Multi-Agent Planning ......................................................................................... 17 
2.3.2 Action Selection Mechanisms ............................................................................. 18 
2.3.3 Coordination for Strategic Actions ...................................................................... 19 
2.3.4 Set-plays ............................................................................................................ 19 
2.3.5 Positional Coordination ...................................................................................... 21 
2.3.6 Coordination Methodologies in FC Portugal ....................................................... 22 

2.4 Conclusion ................................................................................................................. 23 

3 Base Code Study ............................................................................................................ 25 
3.1 Structure of the Base Codes ........................................................................................ 25 

3.1.1 WrightEagle ....................................................................................................... 25 
3.1.2 Helios ................................................................................................................. 27 

3.2 Modifications ............................................................................................................. 28 
3.3 Performance Tests ...................................................................................................... 29 
3.4 Discussion.................................................................................................................. 31 



CONTENTS 

viii 

3.4.1 Structure and ease of modification ..................................................................... 31 
3.4.2 Functionalities Review ....................................................................................... 31 

3.5 Conclusion ................................................................................................................ 32 

4 Matchflow...................................................................................................................... 35 
4.1 Triangulation based Positioning Mechanism .............................................................. 35 

4.1.1 Delaunay Triangulation and Linear Interpolation ................................................ 35 
4.1.2 Formation Analysis ............................................................................................ 37 
4.1.3 Formation Editing Tool ...................................................................................... 38 
4.1.4 Internal Data Structure and Algorithms .............................................................. 41 
4.1.5 Formation File Format ....................................................................................... 42 

4.2 Defining a game flow ................................................................................................ 43 
4.2.1 Generic Strategy for different leagues ................................................................ 43 
4.2.2 Flux Editing Tool ............................................................................................... 45 
4.2.3 Flux File Format ................................................................................................ 46 

4.3 Conclusion ................................................................................................................ 47 

5 Results ........................................................................................................................... 49 
5.1 Formation .................................................................................................................. 49 
5.2 Flux ........................................................................................................................... 52 
5.3 Conclusion ................................................................................................................ 52 

6 Conclusion ..................................................................................................................... 53 
6.1 Future Work .............................................................................................................. 54 

Appendix A: User Guide......................................................................................................... 67 
A.1 Introduction ................................................................................................................... 68 
A.2 Matchflow ..................................................................................................................... 69 
A.2.1 Starting the application ............................................................................................... 69 
A.3 Work Environment ........................................................................................................ 69 

A.3.1 Title Bar ................................................................................................................ 69 
A.3.2 Menu Bar .............................................................................................................. 69 
A.3.3 Tool Bar ................................................................................................................ 70 
A.3.4 Status Bar .............................................................................................................. 70 

A.4 Menu Bar Tools ............................................................................................................ 70 
A.5 Basic Operations with Matchflow .................................................................................. 70 
A.6 Advanced Operations with Matchflow ........................................................................... 71 
A.6.1 Create a formation for a specific league ...................................................................... 71 
A.6.2 Define the players‟ symmetry ..................................................................................... 72 
A.6.3 Define a triangulation ................................................................................................. 72 
A.6.4 Define the players‟ positions in the field ..................................................................... 73 
A.6.5 Delete an existing point in the formation ..................................................................... 74 
A.6.6 Define the players‟ positions when one is in possession of the ball .............................. 74 
A.6.7 Reverse changes made in player in possession ............................................................ 75 
A.6.8 Define flux values for different regions in the field ..................................................... 75 

Appendix B: Formation .......................................................................................................... 77 

Appendix C: Flux .................................................................................................................... 91 
 



 

ix 

List of Figures 

Figure 1.1 - Typical Agent Schema (adapted from [Reis, 2003]) ................................................2 
Figure 2.1 - General overview of RoboCup 2009 in Graz ..........................................................7 
Figure 2.2 – Kick Off of in a Small Size League Game [SSRL, 2010] .......................................7 
Figure 2.3 – Medium Size Robot [Tugraz, 2009] .......................................................................8 
Figure 2.4 – NAO Robot [Tugraz, 2009] ...................................................................................9 
Figure 2.5 – Humanoid Robots [http://www.robocup.at/] ...........................................................9 
Figure 2.6 – 3D Simulation environment [RC2009, 2009] ....................................................... 10 
Figure 2.7 - Mixed-Reality simulation league .......................................................................... 10 
Figure 2.8 – Modules of the Simulator System (adapted from [Almeida R., 2008]) .................. 11 
Figure 2.9 – RoboCup Soccer Monitor version 13.1.0 for Linux .............................................. 12 
Figure 2.10 – SoccerServer Simulator Architecture (adapted from [Reis, 2003]) ...................... 12 
Figure 2.11 – Orientation marks in 2D field [SSERVER, 2009] ............................................... 13 
Figure 2.12 – Set-play definition [Mota and Reis, 2007] .......................................................... 20 
Figure 2.13 – Action definition [Mota and Reis, 2007] ............................................................ 21 
Figure 3.1 - Decision module of the WrightEagle base code .................................................... 26 
Figure 3.2 - Helios base code structural division ...................................................................... 27 
Figure 3.3 – Decision module of the Helios base code ............................................................. 28 
Figure 4.1 – Vertex added inside and lying on an edge of a triangle [Kreveld et al. 2000] ........ 36 
Figure 4.2 - Delaunay Triangulation and Linear Interpolation [Akiyama et al, 2009] ............... 36 
Figure 4.3 - Matchflow initial formation creation screen .......................................................... 38 
Figure 4.4 - Overview of a formation' triangulation ................................................................. 39 
Figure 4.5 - Symmetry between players and Edit Box to give more precision to players' 

positions ................................................................................................................................. 39 
Figure 4.6 - Initial formation screen for a player considered to be in possession of the ball ...... 40 
Figure 4.7 - Some redefined players' positions when player 10 is in possession of the ball ....... 40 
Figure 4.8 - Matchflow partial data structure diagram .............................................................. 41 
Figure 4.9 – Example of some of the possible pass points ........................................................ 44 
Figure 4.10 - Delaunay Triangulation for the definition of the flux values ................................ 45 
Figure 4.11 - Flux values for different regions in the field and flux interpolation ..................... 46 
Figure 5.1 - Difference between old and new positioning when not having the possession of the 

ball ......................................................................................................................................... 50 
Figure 5.2 - Difference between the old and new positioning when having the possession of the 

ball (player 7) ......................................................................................................................... 51 
Figure 5.3 - Comparison between match points made in all tests .............................................. 52 
Figure A.1 - Work environment for the Matchflow tool ........................................................... 69 
Figure A.2 - Matchflow file menu bar ..................................................................................... 70 
Figure A.3 - Matchflow edit mode menu ................................................................................. 70 
Figure A.4 - Matchflow Mode menu ....................................................................................... 70 
Figure A.5 - Matchflow View mode menu............................................................................... 70 



LIST OF FIGURES 

x 

Figure A.6 - Matchflow help mode menu ................................................................................ 70 
Figure A.7 - Matchflow league chosen screen ......................................................................... 72 
Figure A.8 - Matchflow player symmetry and edit box ............................................................ 72 
Figure A.9 - Matchflow: defining the players' positions ........................................................... 73 
Figure A.10 - Matchflow defining players' positions when one has the ball ............................. 74 
Figure A.11 - Matchflow flux values for different regions in the field...................................... 75 



 

xi 

List of Tables 

Table 2.1 - Difference between Chess and RoboCup .................................................................6 
Table 2.2 - Connection Protocol for the Simulator [SSERVER, 2009] ..................................... 14 
Table 2.3 - Action Protocol for the Simulator [SSERVER, 2009] ............................................ 14 
Table 2.4 - Perception Protocol for the Simulator [SSERVER, 2009] ...................................... 15 
Table 3.1 - Base code performance tests results for different situations .................................... 29 
Table 3.2 - Base code functionalities review ............................................................................ 31 
Table 5.1 - Matches against bahia2d ........................................................................................ 50 
Table 5.2 - Matches against ncl09 ........................................................................................... 50 
Table 5.3 - Matches against RoboSampad ............................................................................... 51 
Table 5.4 - Matches against HelliBash ..................................................................................... 51 
 



LIST OF TABLES 

xii 



 

xiii 

Abbreviations 

AI Artificial Intelligence 
ACL Agent Communication Language 

ADVCOM Advanced Communication 

CBR Case-Based Reasoning 
CGs Coordination Graphs 

DPRE Dynamic Positioning and Role Exchange 

FIFA Fédération International de Football Association 

IEETA Institute of Electronics and Telematics Engineering of Aveiro 
KIF Knowledge Interchange Format 

KQML Knowledge and Query Manipulation Language 

LIACC Artificial Intelligence and Computer Science Laboratory 
MAS Multi-Agent System 

MM Mutual Modelling 

SBSP Situation Based Strategic Positioning 
SLM Strategic Looking Mechanism 

SPAR Strategic Positioning using Attraction and Repulsion 



ABBREVIATIONS 

xiv 

 

 



 

1 

1 Introduction 

1.1 Context 

Deep Blue's defeat of the World Chess Champion Garry Kasparov in 1997 [DeepBlue, 

1997] marked one of the great accomplishments in artificial intelligence during the previous 

century. The victory of Deep Blue cannot be seen as a victory of machine over man, but a 
victory of men over man. A group of dedicated scientists, with one goal on their mind – 

building a computer system that could beat the world champion - made this possible. 

Robotic Soccer arises as a new domain and due to its complexity poses even more 
challenges than before. The Robot Word Cup Initiative – RoboCup – is an international 

investigation and educational project promoting research in (Distributed) Artificial Intelligence. 

It provides a standard problem – soccer – as a mean to stimulate the research in Artificial 

Intelligence and Intelligent Robotics, being an excellent stage to compare the different research 
approaches of the participants. 

RoboCup has different leagues which can be divided in two types: robotic leagues using 

physical robots and simulation leagues using virtual robots. Each league has its own set of 
challenges to successfully build a team of cooperative robots in order to be able to play a soccer 

match. Coordination methodologies are necessary, especially for the simulation league, since 

there are no hardware advantages – like physical sensors or actuators in robotic leagues – 

focusing in developing new methods for achieving an effective teamwork. 
FC Portugal team was developed in collaboration by the University of Porto and 

University of Aveiro and has been participating in RoboCup since 2000. Great results have been 

achieved such as six European Championships and three World Championships [Reis, 2003] 
[Lau and Reis, 2007]. 

1.2 Agent and Multi-Agent System 

Object-oriented applications are becoming less common because the nature of the 

problems is changing. An open and distributed environment is emerging and centralized 
approaches are less suitable to solve problems in this kind of environment. Agent-oriented 

applications are a good paradigm to solve problems in open, heterogeneous and distributed 

environments. The main difference between agents and objects was introduced by Wooldridge: 
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“Objects do it for free; agents do it because they want to” [Wooldridge, 2002]. An object can be 

demanded to perform a task, but an agent makes an autonomous decision, whether or not that 

action would benefit him or not, maintaining control over his state and behaviour.   
There are several definitions of what is an agent but there is no generally accepted one. 

Based on the work of Wooldridge and Jennings [Wooldridge and Jennings, 1995] [Wooldridge, 

2002], Pattie Maes [Maes, 1996] and Russel and Norvig [Russel and Norvig, 1995], Reis 

proposed the following definition: agent is defined as a computational system situated in a 
given environment, has perception of it though his sensors, capable of reasoning, behaving in 

an autonomous manner in the environment through his actuators in order to accomplish the 

task which was projected [Reis, 2003]. Some authors also consider that an agent should have 
communication capabilities with other agents/humans [Genesereth and Ketchpel, 1994]. If an 

agent has a physical presence – a body - it is called a robotic agent. 

 

 
Figure 1.1 - Typical Agent Schema (adapted from [Reis, 2003]) 

A Multi-Agent System is composed by several autonomous agents that at the same time 

interact with each other. An Agent situated in a Multi-Agent environment should maintain his 

autonomous behaviour, making his own decisions in order to accomplish his goals. The 
presence of other agents in an environment indicates that the agent is not alone, other agents 

may share the same goals or the opposite goals, or others. Coordination may be needed to 

achieve the individual agents‟ goals. Coordination may be achieved through negotiation or 
cooperation. 

Due to the importance of the use of a common language some were developed during the 

years: 

 KIF (Knowledge Interchange Format). KIF is meant to represent knowledge on a 

specific domain, possible to be interpreted by both humans and computer 

programs. It was primarily developed to express the contents of KQML messages 

[KIF, 1992]. 

 KQML (Knowledge and Query Manipulation Language). KQML is a language 

and protocol communication among agents. It specifies all necessary information 
for message content understanding. Each message is comprised of a performative 

(message type), and a number of parameters with respective value [KQML, 

1994]. The growth of the language brought some backwards compatibility 
problems [KQML, 1997] and KQML was superseded by FIPA-ACL. 

 FIPA ACL (Agent Communication Language), a language similar to KQML, but 

containing a lot less performatives and more adequate to negotiation processes 

[FIPA, 2002]. 
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1.3 Coordination in Multi-Agent System 

Despite several definitions [Malone and Crowston, 1994] [Jennings, 1996], coordination 

can be defined as the act of working together in a harmonious way in order to achieve an 

agreement or a common goal [Reis, 2003]. Coordination is necessary or desired for various 

possible reasons: 

 Dependency relationships between agents 

 Knowledge and resources: necessity to coordinate actions since no agent have 

all knowledge or resources to solve the task 

 Global restrictions such as time, cost and resources 

 

Woodridge identified two major difficulties in multi-agent coordination [Woodridge, 
2002]: 

 Agents designed by different developers can have distinct goals, thus introducing 

the need to negotiate, in order to persuade each other into cooperation. 

 Given the agents‟ autonomy and real-time decision making, they must coordinate 

their actions with other agents present in the system also in real-time. 

 
A Multi-Agent system can be categorized in terms of the agents‟ relationships – comprised 

by competitive agents or composed by cooperative agents. The first are usually designed by 

several persons, with their own agenda and motivation. The latter are usually projected by a 
single person and have a sense of global utility and welfare. In the context of a soccer team, all 

the players have the same goals and behave like a team, so cooperative methodologies analysis 

will be the focus of this report. 

1.4 FC Portugal 

FC Portugal team was developed in collaboration by the University of Porto and 

University of Aveiro and has been participating in RoboCup since 2000. Great results have been 

achieved such as five European Championships and three World Championships [Reis, 2003]. 
The Simulation League Team became RoboCup 2000 European Champion in Amsterdam and 

RoboCup 2000 World Champion in Melbourne. The team also won the Coach Competition in 

2002 and RoboCup Simulation 3D league in 2006. FC Portugal is developed at two research 
laboratories in collaboration: LIACC (NIAD&R) / University of Porto and IEETA / University 

of Aveiro. The project started in February 2000 [FC Portugal, 2006]. 

In this thesis, to test the applications developed and prove the validity of the underlying 

concepts, special focus will be given to the 2D Simulation League and the FC Portugal team. 

1.5 Motivation and Objectives 

The fact that soccer became a standard problem to Distributed Artificial Intelligence and 

Intelligent Robotics was a great factor of motivation due to the author‟s personal passion for 
soccer. Also, the opportunity to participate in an interesting project in a research area that will 

be even more important in the future was the main motivation. Additionally, the opportunity to 

work in team with highly interesting and motivating people and participate in an international 
event like RoboCup was also a factor of great motivation. 

The RoboCup competition has the robotic soccer divided in different leagues, each one of 

them having their own unique challenges, but all of them sharing the need for coordination. 

Generic coordination methodologies that can be applied to different leagues, with the necessary 
adjustments, can be easily integrated in all of them, speeding up the development of each team 

http://www.ncc.up.pt/liacc/
http://www.ua.pt/
http://www.ua.pt/
http://www.ua.pt/
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and improve its quality. Sharing a common framework, all coordination methodologies are 

subject of continuous research and improvement. 

The goals of this thesis are to work on high-level coordination methodologies that can be 
applied to different leagues, thus creating a generic and common framework. Those 

methodologies are meant to achieve positional coordination and to define game flow of the 

players/agents in the robotic soccer simulation leagues. Also, the development of a software 

application that allows defining advanced formations and game flow for the various leagues is 
necessary. 

The final goal is to have the necessary tools to have a high-level process to define 

advanced formations and game flow in the different leagues, enabling the team to have a 
flexible strategy that can easily exploit other teams‟ weaknesses.  

1.6 Thesis Outline 

This introductory chapter presents the context of this thesis report emphasizing the 

importance of developing coordination methodologies to achieve teamwork in Multi-Agent 
Systems. Chapter 2  presents the RoboCup Initiative, describing the different leagues that are 

integrated in the competition and their motivations, and a more detailed overview of the 2D 

Simulation Also this chapter contains the state of the art relative to cooperation in MAS, more 
specifically coordination methodologies in terms of set-plays, plan-based coordination and high-

level positioning. Chapter 3 contains a study related to the released base codes for the 2D 

Simulation league, where some tests and analysis were conducted in order to measure the 
quality and usefulness of each one. Chapter 4 contains a thorough description of the developed 

graphical tool, and the concepts involved, which allowed the definition of advanced formations 

and game flow. In chapter 5 a review of the developed tool and the integration in the three 

leagues is available. Also, results of performance tests on the effectiveness of the new formation 
mechanism conducted in the 2D Simulation league are presented. Finally chapter 6 presents the 

conclusions and future work. 

 



 

5 

2 Team Level Coordination in RoboCup 

2.1 RoboCup 

RoboCup is an international initiative to promote the development of AI and intelligent 

robotics research by providing a standard problem – robotic soccer – where a wide range of 
technologies can be integrated and examined. The first official RoboCup competition took place 

in the year of 1997 in the city of Nagoya, Japan. 

While soccer game is used as a standard problem, the RoboCup Initiative also promotes 
other challenges in more socially useful domains. The RoboCup Rescue stimulates the use of 

the research made for robotic soccer to be applied on rescue missions in large disasters. The 

RoboCup Junior is targeted for the youngsters, sparking their curiosity and increasing their 

comfort with technology [Junior, 2010]. Since 2006 RoboCup embraced a new domain – 
RoboCup Home – which aims to develop service and assistive robot technology with high 

relevance for future personal domestic applications [Home, 2010].  

2.1.1 Objectives 

The objective of the RoboCup initiative is to promote research in Artificial Intelligence 

and Intelligent Robotics by providing a realistic, but affordable, problem for many research 
groups. Not only should be stimulating in a scientific point of view, but also attractive by the 

general public and media. One of the effective ways to achieve this is by setting goals. 

The ultimate goal of RoboCup Initiative is that “By mid21st century, a team of fully 
autonomous humanoid robot soccer players shall win the soccer game comply with the official 

rule of the FIFA, against the winner of the most recent World Cup” [Kitano, 1997]. This goal is 

shared by the Robotic and AI research community to be the one of the grand challenges for the 

next 40 years. Although this seems highly ambitious, the same could be said some years ago 
about the Apollo project which was intended to “landing a man on the moon and returning him 

safely to earth” [Kennedy, 1961]. Although it represented a historical landmark for humanity at 

the time, the accomplishment of this goal didn‟t have a great impact socially or economic. The 
benefit came from the scientific and technology advances originated in pursue of the goal which 

came the foundation of the today American industry. The important issue is to set the goal high 

enough so that a series of technical breakthrough is necessary to accomplish the task and the 
goal need to be widely appealing and exciting [RoboCup, 2010]. 
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One of the key aspects is to view RoboCup as a standard problem so that various 

theories, algorithms, and architectures can be examined and compared. Chess was the main 
domain for several years but after the victory of Deep Blue – computer - over Gary Kasparov 

[DeepBlue, 1997], using the official rule, the goal was reached and new challenges were 

needed. The main differences between Chess domain and RoboCup are presented in the 
following table. 

 
Table 2.1 - Difference between Chess and RoboCup 

 Chess RoboCup 

Environment Static Dynamic 

State Change Turn taking Real time 

Info. Accessibility Complete Incomplete 

Result of actions Deterministic Nondeterministic 

Sensors Readings Symbolic Non-symbolic 

Control Central Distributed 

 

Analysing the Table 2.1 it is clear that RoboCup is a domain with more complexity than 

Chess. These characteristics will be further analysed concerning the 2D Simulation League. 

2.1.2 History 

The idea of robots playing soccer was introduced by Alan Mackworth (University of 

Columbia, Canada) in a paper entitled “On Seeing Robots” presented at 1992 [Mackworth, 
1993]. In October of the same year, a group of independent researchers organized a Workshop 

about the grand challenges in AI in the city of Tokyo. This Workshop led to a serious of 

discussions of using game of soccer for promoting science and technology, studies related to 
technology feasibility, social impact and financial feasibility. The result of the study was the 

launch of the first competition in June 1993, named Robot J-League. After receiving 

overwhelming reactions from research groups outside of Japan, the project was extended 
internationally, and renamed as Robot World Cup Initiative - RoboCup. The first official 

RoboCup games and conference was held in 1997 with great success. Over 40 teams 

participated, and over 5.000 spectators attended. Over the years the number of teams has been 

increased such as the number of spectators. In the last RoboCup – 2009 in Graz - a total of 
2.300 participants from 44 nations arrived to compete in several disciplines, thrilling thousands 

of visitors in the process. 
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Figure 2.1 - General overview of RoboCup 2009 in Graz 

2.1.3 Small-size League 

The Small-size League, or F180, consists in teams composed by 5 players that play in a 

6.05x4.05m green-carpeted field with an orange golf ball. Since the league permits the use of 
global vision and robot‟s centralized control it is considered a hybrid centralized/distributed 

system. 

 

 
Figure 2.2 – Kick Off of in a Small Size League Game [SSRL, 2010] 

 

During the game an external camera captures the global vision information and sends it to 

an off-field software developed by each team. Then, this software is responsible for sending out 
commands to the robots using wireless communication. Due to this centralized control, more 

focus has been given to high speed and precise control, thus been called the „engineering 

league‟. Developments in subjects like electromechanical design, control theory and digital 

electronics, have been crucial in this league [Stone et al., 2001] [Birk et al., 2002]. 
It is a very interesting and challenging domain as to build a successfully team require 

clever design, implementation and integration of many hardware and software subcomponents 

into a robustly functioning whole [SSRL, 2009]. 

2.1.4 Middle-size League 

The middle-size league poses a unique combination of research challenges encountered in 
the simulation and small-size league. Each team can have up to 5 players and the game is played 

in an 18x12m field with a coloured ball. In this modality, teams are composed of wheeled 

robots with a maximum height of 80cm and a maximum weight of 40Kg. Each robot is 
equipped with sensors and an on-board computer to analyze the current game situation and 
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successfully play soccer. To simplify the perception and world state modelling several 

constraints were established: the ball has a pre-defined colour, the field is green, the field lines 
are white, the players are black, etc. Robots must recognize objects, locate themselves, choose 

the actions to perform, controls motors and actuators autonomously. 

Through wireless communication they can establish inter-team cooperation and receive all 
referee commands. The referee orders are communicated to the teams using an application 

called “referee box”. The referee box can send the referee orders to the team through a wired 

LAN TCP link connected to the base station of each team and another recently option is via 

wireless UDP multicast. It‟s each team‟s responsibility to communicate these orders to the 
robots in the field via standard wireless LAN. The base station can also perform the role of a 

coach, analyzing the game and sending high-level instructions to the players. The intervention 

of humans is not allowed except for placing or removing robots from the field [MIDDLE, 
2009]. 

 

 
Figure 2.3 – Medium Size Robot [Tugraz, 2009] 

 

In past RoboCup editions most of the teams were dedicated in developing new hardware 

capabilities, and only few teams introduced high-level approaches [Weigel et al., 2001] [Hafner 
and Riedmiller, 2003] [Lau et al., 2010]. However, the focus on high-level methodologies is 

becoming more important as the size of the field and the total number of players tends to 

increase. Approaches initially introduced and tested in the RoboCup simulation league are being 

gradually adopted by other leagues. In particular, the soccer notions of “formation” and “role” 
have been used since RoboCup 2000. The CAMBADA team is an example of that kind of 

integration, where the adaptation of SBSP and DPRE to the Middle-size league [Bartolomeu et 

al, 2005] resulted in a coordinated behaviour of the team that contributed to its recent successes 
[Lau et al., 2008] [Lau et al, 2009a] [Lau et al., 2009b]. 

In recent years research made good progress. Not long ago the robots were only able to 

distinguish their own goal from the opponent goal by the goal colour. At this year's tournament 
all teams were able to play with net goals only. The ball is the only item that is still colour-

marked [RoboCup2010, 2010]. 

2.1.5 Standard Platform League 

The RoboCup Standard Platform League had its debut in 2008. Each team competes with 

identical robots – the current standard platform used is the humanoid NAO by Aldebaran 

Robotics [TZI, 2009]. 



Team Level Coordination in RoboCup 

 9 

 
Figure 2.4 – NAO Robot [Tugraz, 2009] 

 

The field is 6x4m and the teams can have a maximum of three robots. In addition to the 
league, there are three technical skill challenges: “Any Ball”, the Passing and the Localization 

with Obstacle Avoidance challenges [CHALLENGES, 2009]. 

2.1.6 Humanoid League 

In the humanoid league, robots have human-like body plan and senses. It is considered to 

be one of the most dynamically progressing leagues and the one closest to the 2050 goal. Each 

team has a maximum of three robots that plays a match in a 6x4m field. There are two sizes 
classes: KidSize - 30x60cm – and TeenSize – 100x160cm. 

 

 
Figure 2.5 – Humanoid Robots [http://www.robocup.at/] 

 

Some issues investigated in this league are dynamic walking, running, and kicking the ball 
while maintaining balance, visual perception of the ball, other players, and the field, 

selflocalization, and team play among others. Also in this league there are some technical 

challenges [TZI, 2009] [HUMANOID, 2009]. 

2.1.7 Simulation League 

Unlike other leagues, in this one there isn‟t any real robot, only a software agent. A server 
– soccer server – simulates the players and the field. The server sends (imperfect) perception 

information to the players, accepts low-level commands from the players, executing them in an 

imperfect way. There are two kinds of simulation leagues: 2D and 3D. The 2D Simulation 

league will be described in further detail in the next section as this work is mainly based on it. 
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Figure 2.6 – 3D Simulation environment [RC2009, 2009] 

 

The 3D league robot was introduced in 2004 and is currently a simulation of the NAO 
robot used in the Standard Platform League. One of the objectives of the simulation league 

consists in testing high-level multi-agent coordination methodologies while waiting for the 

hardware to keep up. The 3D Simulation league introduces a new set of research problems, 

since the physics dynamics model is much more precise than in the 2D league. Not only the aim 
is to draw strategic behaviour in playing soccer but also the creating of basic controls like 

walking, kicking, turning and standing up [RC2009, 2009]. The 3D simulation league has drawn 

a lot of interest in the community and is currently the competition with more teams involved. 

2.1.8 Mixed-Reality League 

Another league using simulation is the Mixed Reality league: a standard research and 
educational platform integrating cutting edge and low cost watch technology into a miniature 

multi-robot system which mixes reality and simulation. It is based on 2cm tall robots that 

operate on a horizontally mounted display. Whilst the robots are real, the ball and the 

environment are virtual. Robots are remote controlled by individual software agents via 
Infrared. 

 

 
Figure 2.7 - Mixed-Reality simulation league 

 
The number of players per team is growing: in the first two years the system could support 

only 2 vs. 2 matches. In 2009 matches were 5 vs. 5. As the goal is to play soccer as much real as 

possible, teams are working on solutions that make 11 vs. 11 games feasible [RMRL, 2010]. 

2.2 The 2D Simulation League 

The simulation league is based on the RoboCup Soccer Server Simulator – SoccerServer. 

It simulates a soccer match between two teams of eleven autonomous agents and a coach. The 

server was designed as a Multi-Agent simulation environment, containing uncertainties, errors 
and real-time operation, enabling the competition between virtual players, each one separately 
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controlled by an autonomous agent [Reis, 2003]. A simulated environment provides the chance 

of researchers to focus on more high-level problems as coordination and learning. 
It is one of the oldest leagues in RoboCup, the first server was completed in the year of 

1995, and the year that followed already held a preRoboCup [Chen et al., 2003]. In this section 

it will be described all the relevant characteristics of the simulator as this league will have a 
special focus on this work. 

2.2.1 Constitution of the System 

The system of the simulated soccer is constituted by three modules: the simulator 

(rcsoccerserver), monitor (rcssmonitor) and video (rcsslogplayer). 

 

 
Figure 2.8 – Modules of the Simulator System (adapted from [Almeida R., 2008]) 

 
The Simulator is the system that allows the execution of the games, containing all the 

information related to the match, receiving commands from the players and sending them 

imperfect information about the environment. Several monitors can be attached to the Simulator 
(even monitors with 3D capabilities) to extend the visualization of the soccer match. The 

Simulator also records the game into a log file so that it can be watched again in another time 

using the LogPlayer. 
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Figure 2.9 – RoboCup Soccer Monitor version 13.1.0 for Linux 

 

Each team is composed by eleven players and eventually a coach, connecting to the server 

via UDP sockets, thus permitting the development of the teams in any programming language or 

operation system if UDP/IP communication is supported. The system presents the following 
client-server architecture. 

 

 
Figure 2.10 – SoccerServer Simulator Architecture (adapted from [Reis, 2003]) 
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The Soccer Server runs cyclically in regular time intervals (100ms). In each cycle the 
server receives commands from the players indicating their intended actions (turn, dash, kick, 

etc.), and if those actions are valid, updates the environment accordingly. In addition, the server 

sends the players their sensorial information, like visual information indicating the players or 
objects that the player is seeing, hearing information relative to the messages that the player can 

listen according to his position, his level of stamina, etc. 

2.2.2 Rules 

The rules of the simulated soccer are very similar to the real world soccer, thus a basic 

knowledge of those rules is fundamental. 

In order to the agents coordinate themselves in the field, there are several orientation marks 
around and inside of the field, delimiting the play area or indicating key spots, helping the 

players positioning on the field. The Figure 2.11 shows the virtual field with 105x68m 

dimensions and the existing marks. 
 

 
Figure 2.11 – Orientation marks in 2D field [SSERVER, 2009] 

 

A virtual referee assures during the game that all the rules are respected by all the players. 

However, in some special occasions like obstructions or lack of fair-play, a human referee may 
intervene in the game. Soccer Monitor provides an interface so that the human referee can easily 

call a foul or repositioning the ball in a specific place. 

2.2.3 Communication Protocol 

The communication between the players and the simulation follows a series of well 

defined protocols. The protocols are concerned about connections, actions and perceptions. 
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2.2.3.1 Connection Protocol 

This protocol allows the players to connect or disconnect to/from the server. The following 
table shows the necessary parameters. 

 
Table 2.2 - Connection Protocol for the Simulator [SSERVER, 2009] 

Connection (Client to Server) Connection (Server response) 

(init <TeamName> [(version <VerNum>)] [(goalie)]) 

<TeamName> ::= (-|_|a-z|A-Z|0-9)+ 

<VerNum> ::= the protocol version (e.g. 13) 

(init <Side> <Unum> <PlayMode>) 

<Side> ::= l | r 

<Unum> ::= 1 ~ 11 

<PlayMode> ::= one of play modes 

(error connection_failed) 

(error illegal_command_form) 

(error illegal_teamname) 

(error illegal_teamname_or_too_long_teamname) 

(error no_more_team) 

(error 

no_more_player_or_goalie_or_illegal_client_version) 

Reconnection (Client to Server) Reconnection (Server response) 

(reconnect <TeamName> <Unum>) 

<TeamName> ::= (-|_|a-z|A-Z|0-9) 

<Unum> ::= 1 ~ 11 

(reconnect <Side> <PlayMode>) 

<Side> ::= l | r 

<PlayMode> ::= one of play modes 

(error connection_failed) 

(error socket_open_failed) 

(error illegal_command_form) 

(error illegal_client_version) 

(error no_such_team_or_player) 

(error cannot_reconnect_while_playon) 

Disconnection (Client to Server) Disconnection (Server response) 

(bye)  

 

2.2.3.2 Action Protocol 

This protocol allows the players to perform actions. The following table shows the 

necessary parameters. 

 
Table 2.3 - Action Protocol for the Simulator [SSERVER, 2009] 

Action (Client to Server) Only once per  cycle 

(attentionto <Side> <Number>) 

(attentionto off) 

<Side> ::= l | r | our | opp | TeamName 

<TeamName> ::= (-|_|a-z|A-Z|0-9)+ 

<Number> ::= 1 ~ 11 

No 

(catch <Direction>) 

<Direction> ::= minmoment ~ maxmoment degrees 
Yes 

(change_view <Width> <Quality>) 

<Width> ::= narrow | normal | wide 

<Quality> ::= high | low 

No 

(dash <Power> <Direction>) 

(dash <Power>) 

<Power> ::= min_dash_power ~ max_dash_power 

<Direction> ::= min_dash_angle ~ max_dash_angle 

If <Direction> is omitted, 0 direction is used automatically. Note: backward dash consumes double 

stamina. 

Yes 

(kick <Power> <Direction>) 

<Power> ::= manpower ~ maxpower 

<Direction> ::= minmoment ~ maxmoment degrees 

Yes 

(move <X> <Y>) 

<X> ::= any real number 

<Y> ::= any real number 

Note: the automatic referee adjusts players' positions if they are out of the pitch. 

Yes 

(pointto <Distance> <Direction>) 

(pointto off) 
<Distance> ::= any real number 

No 
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<Direction> ::= any degree 

pointto is relative to the direction of the face angle(global neck angle). 

(say “Message”) 

(say <Message>) 

<Message> ::= a message 

Note: a double-quated message is recommended to avoid unexpected parsing results. 

No 

(tackle <Direction>): if client version is 12 or later 

(tackle <Power>): otherwise 

<Direction> ::= minmoment ~ maxmoment degrees 

<Power> ::= -max_back_tackle_power ~ max_tackle_power 

Yes 

(turn <Moment>) 

<Moment> ::= minmoment ~ maxmoment degrees 
Yes 

(turn_neck <Angle>) 

<Angle> ::= minneckmoment ~ maxneckmoment degrees 

turn_neck is relative to the direction of the body. Can be invoked in the same cycle as a turn, dash, 

kick or tackle. 

Yes 

Action (Response from Server)  

(error unknown_command)  

(error ilegal_command_form) 
 

 

2.2.3.3 Perception Protocol 

This protocol allows the players to retrieve information from the world. The following 
table shows the necessary parameters. 

 
Table 2.4 - Perception Protocol for the Simulator [SSERVER, 2009] 

Perception (Server to Client) 

(hear Time referee Message)  

(hear Time Sender "Message")  

(hear Time Direction our UniformNumber "Message") 

(hear Time Direction opp "Message") 

(hear Time our UniformNumber) 

(hear Time opp) 

(hear Time Online_Coach Coach_Language_Message) 

Sender ::= online_coach_left | online_coach_right | coach | self  

Time ::= simulation cycle of the soccerserver  

Direction ::= = -180 ~ 180 degrees 

UniformNumber ::= = 1 ~ 11  

Message ::= string 

Online_Coach ::= online_coach_left | online_coach_right 

Coach_Language_Message ::= see the standard coach language section 

(see <Time> <InfoObj>)  

<Time> ::= simulation cycle 

 <InfoObj>  ::=  (<ObjName>  <Distance>  <Direction>  <DistVar>  <DirVar>  <DirBody>  

 <DirCabeça> [<PointingDir>] [t|k])  |  (<ObjName>  <Distance>  <Direction>  <DistVar>  <DirVar> [<PointingDir>] 

[t|k])  |  (<ObjName>  

<Distance> <Direction>) | (<ObjName> <Direction> [<PointingDir>] [t|k]) 

 <ObjName>  ::=  (p   <TeamName> [<Unum> [goalie]]])  |  (b)  | g [l|r]  |  (l [l|r|t|b])  |  (f c)  |  (f [l|c|r] [t|b])  |  (f  p  [l|r]  

[t|c|b])  |  (f g  [l|r]  [t|b])|  (f  [l|r|t|b]  0)  |  (f  [t|b]  [l|r]  [10|20|30|40|50])  |  (f  [l|r]  [t|b] [10|20|30])  

<Distance> ::= Real positive 

 <Direction> ::=[-180.0 .. 180.0] 

<DistVar> ::= Real  

 <DirVar> ::= Real  

<DirBody> ::= [-180.0, 180.0]  

<DirHead>::= [-180.0, 180.0]  

<PointingDir>::= [-180.0, 180.0]  

<TeamName> ::= [string]  

<Unum> ::= [1..11] 

(sense_body <Time>  

(view_mode {high | low} {narrow | normal | high})  

(stamina <Stamina> <Effort> <Stamina> <Capacity>)  

(speed <AmountOfSpeed> <DirectionOfSpeed>)  

(head_angle <HeadAngle>)  

(kick <KickCount>)  

(dash <DashCount>)  

(turn <TurnCount>)  

(say <SayCount>)  
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(turn_neck <TurnNeckCount>) 

(catch <CatchCount>)  

(move <MoveCount>)  

(change_view <ChangeViewCount>)  

(arm (movable <ArmMovableCycles>) (expires <ArmExpiresCycles>) (target <ArmTargetDistance> <ArmTargetDirection>) 

(count <PointtoCount>))  

(focus (target {none | l <UniformNumber >| r <UniformNumber> }) (count <AttentiontoCount>)) (tackle (expires 

<TackleExpiresCycles>) (count <TackleCount>))  

(collision {none | [(ball)] [(player)] [(post)]})) 

<Time> ::= simulation cycle of the soccerserver 

<Stamina> ::= positive real number 

<Effort> ::= positive real number 

<StaminaCapacity> ::= positive real number 

<AmountOfSpeed> ::= positive real number 

<DirectionOfSpeed> ::= -180 ~ 180 degrees 

<HeadAngle> ::= -180 ~ 180 degrees 

<*Count> ::= positive integer 

<ArmMovableCycles> ::= positive integer 

<ArmExpiresCycles> ::= positive integer 

<ArmTargetDistance> ::= positive real number 

<ArmTargetDirection> ::= -180 ~ 180 degrees 

<UniformNumber> ::= 1 ~ 11 

<TackleExpiresCycles> ::= positive integer 

2.2.4 Coach 

The coach has the responsibility to manage the team in order to reach the victory in a 

match. He can change the tactic during the game or making the right substitutions to increase 
team performance. In the 2D Simulation league the coach can receive messages from the 

players and the referee; he can also send messages to all players but only when the game is 

stopped. However, the coach has other kind of restrictions like it happens in the real world. 

The simulation can support two kinds of coaches: an online coach and an off-line coach. 
Both of them receive global information without imperceptions from all objects presented in the 

simulated field. 

2.2.4.1 Offline Coach 

An offline coach is meant to aid the development of the team, not being able to participate 

in an official competition. He can control all what happens in the field, like ball and players 
positions, deactivate the virtual referee, and force a game mode, or changing player‟s velocity or 

direction. It is a great tool to test the performance of the team in specific situations of the game. 

2.2.4.2 Online Coach 

An online coach can participate in the official competitions but he can‟t control the players 

or what happens on the field in a direct way. He receives global and error free information from 

the simulation, and since he has no restriction in time to make a decision, he can spend most of 
his time doing more complex task like analysing the opponent behaviour and evaluating the best 

strategy to increase the team performance. The coach can only communicate with the players 

when the game is stopped, giving all kinds of tactical advices. 

2.2.4.3 Language of Communication 

The first standard language of communication developed was made publicly in January of 

2001, with a great support from the RoboCup community. COACH UNILANG presented a 
high-level approach based on several concepts of soccer like: regions, time periods, situations, 

tactics, formations, types and behaviours of players. It allowed the definition of generic soccer 

tactics in a direct and simple way [Reis and Lau, 2002]. 
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The RoboCup federation, however, chose as the standard communication language, a 

low-level approach called Clang [Chen et al., 2003]. Though, many of the concepts of COACH 
UNILANG were introduced in the Clang language over the years. 

2.2.5 Motivation and Challenges 

In chapter 2.1.1 a table (Table 2.1) was shown that depicted the main differences between 

the domain of Chess and the domain of RoboCup. The 2D Simulation League reflects those 

characteristics: 

 Dynamic Environment. While the players decide their next action, the ball is moving, 

as well as his teammates and opponents. In Chess, players decide what to do in turns; 

 Incomplete Accessibility. Players have limited perception of the world state. They are 

limited to the sensors capacity. In Chess, all the information is known; 

 Nondeterministic. The results of actions are not assured, nor easily predictable; 

 State change. All the variables in RoboCup are continuous. The number of possible 

states is virtually infinite, making this a domain even more complex than Chess; 

 Distributed. A number of autonomous agents have to act in an autonomous and 

coordinate manner in order to achieve a common goal. 

2.3 Coordination of Cooperative Agents 

Another designation for the coordination of a team of cooperative agents is the 

denomination of Teamwork. Teamwork can be defined as a cooperative effort by the members 

of a team in order to attain a common goal [AHD, 2000]. The importance of this concept has 
been recognized in many areas, such as: virtual training [Tambe, 1995] [Rao et al., 1993], 

interactive education, integration of information in the Internet [Williamson et al., 1996], 

simulated robotic soccer [Kitano, 1997], interactive entertainment [Hayes-Roth et al., 1995] and 
multi-robot missions. 

2.3.1 Multi-Agent Planning 

One of the first coordination methodologies was suggested in the early eighties by Smith 

and Davis [Smith and Davis, 1981]. A three stage approach was proposed: 

 

1. Problem Decomposition into smaller ones, with the least of dependencies. 

2. Individual solving of the small problems, which can involve task allocation 

and information exchange. 

3. Solution integration in a global solution. 

 
This allowed two major forms of cooperation – task-sharing and result-sharing. The 

Contract-Net protocol is the most popular method regarding task sharing; the protocol starts 

with an agent that needs a task to be done. It sends a message, specifying the tasks and 

restrictions, to agents capable of executing the task, which in turn respond with a proposal or 
refusal. The organizing agent then sends an acceptance or refusal of the received proposals 
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[FIPAb, 2002]. As to result-sharing, Durfee suggests [Durfee, 1999] agents can improve, using 

this kind of cooperation, their performance in terms of: 
 

 Confidence more error detection, increasing global confidence on the solution; 

 Completeness combined local vision can produce more global vision of the problem 

and solution; 

 Precision sharing results can improve the global solution; 

 Time the necessary time to reach solution can diminish. 

 
Another type of coordination is Multi-Agent Planning with three identified possibilities – 

centralized planning of distributed plans, distributed planning of a global plan and distributed 

planning of distributed plans [Durfee, 1999]. A centralized planning, although preferable, is not 
always possible or desirable, due to the distributed nature of the problem. Partial Global 

Planning was proposed by Durfee and Lesser and is based on information exchange by the 

agents in order to reach a global solution for a given problem. Every agent is responsible to 
form local plans and adapt them with the exchanged information, resulting in a global plan to 

reach the solution of the problem [Durfee and Lesser, 1987]. Later, in the mid-nineties, Decker 

extended this mechanism into a Generalized Partial Global Planning [Decker, 1995]. 

The Joint Intentions Framework was proposed by Cohen et al. [Cohen et al., 1990]. It 
describes how the agent‟s intentions relate to his beliefs, commitments and actions. It is focused 

on the joint mental state of a team. 

Stone and Veloso [Stone, 1998] [Stone and Veloso, 1999] introduced the Locker Room 
Agreement (LRA) as a mechanism of high-level coordination useful in domains with limited 

communication. It is based on a team flexible structure definition, roles specifying agent 

behaviour and role switch mechanisms, formations composed with a set of roles and triggers for 
their activation, and set-plays for specific situations. Despite some authors think that the use of 

pre-defined actions is not flexible enough in dynamic environments, the success of the Locker 

Room Agreement in the simulated robotic soccer proved the contrary. Another methodology 

useful in environments with limited communication is Mutual Modelling, which was introduced 
by Genesereth [Genesereth et al., 1986]. According to this approach, each agent creates a model 

of every other agent in the team, thus allowing it to predict their actions. A similar cooperation 

method was used in MACE, one of the first testing environments for Multi-Agent Systems 
[Gasser et al., 1987]. 

Several more methodologies were proposed, many of them applied to the RoboCup 

environment. However, most of the implemented systems do not provide the flexibility to 

dynamically rearrange teams and roles according to various situations. Also, most coordination 
methodologies do not deal well with space mobility, which is an essential aspect in domains like 

RoboCup. 

2.3.2 Action Selection Mechanisms 

Deciding what action to take in a given moment is very important in a soccer game. A 

player‟s individual decision typically depends on the action performed, or expected, of other 
players and balances its possible risks and rewards. However, in a dynamic environment with 

continuously changing state, these dependencies can rapidly change. One of the first action 

selection mechanisms proposed used player roles and a measurement level of how opponents 
could interfere in the current situation using multi-layer perception [Kim et al., 1997] for this 

purpose. 
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Coordination Graphs (CGs) [Kok et al., 2003] was proposed on the assumption that in 

most situation only a small number of players need to coordinate their actions while the 
remaining are capable of making their own decisions. This mechanism has been widely adopted 

and several methods were applied to improve its efficiency (e.g. max-plus algorithm [Kok and 

Vlassis, 2005] and simulated annealing [Dawei and Shiyuan, 2007]). 
An approach consisting of neuro-fuzzy systems and bidirectional neural networks was 

proposed. The model‟s action selection is based on analysis of several possible actions which 

are generated by the agent in each cycle. The action selection mechanism is based on 

probability/priority models: the probabilities are determined by neuro-fuzzy systems and 
bidirectional neural networks and the priority is based on a system that maps human knowledge 

to the action selection method [Zafarani and Yazdchi, 2007]. 

Most recently, Ros et al. [Ros et al., 2009] successfully applied Case-Based Reasoning 
(CBR) techniques to model the action selection of a team. This approach explicitly distinguishes 

between controllable and uncontrollable indexing features, corresponding to the positions of the 

team members and opponent robots. 

2.3.3 Coordination for Strategic Actions 

Reis et al. [Reis and Lau, 2001] [Reis et al., 2001] extended the work of Stone and Veloso 

[Stone, 1998] [Stone and Veloso, 1999] and proposed exchange of roles and positioning for 
heterogeneous players based on the concept of utility in the context of the simulated robotic 

soccer. 

A strategy for role assignment was introduced by [McMillen and Veloso, 2006] in the 
four-legged league. This strategy implies the communication of the currently chosen Play – 

which is chosen by a lead player – which provides a set of Roles to be assigned to all the team 

players. Each Role defines the behaviour of the player. Since there are no concept of transitions 
and steps, a Play is merely a concept aiming at distributing roles among all the players. 

For role assignment in the middle-size CAMBADA team, a dynamic algorithm that adapts 

the formation to a possible varying number of active robots is used, which will assign each 

role/robot to the strategic positionings according to priorities and number of active robots [Lau 
et al., 2009a] [Lau et al., 2009b]. 

The RFC Stuttgart/CoPS team uses Special Interaction Nets [Zweigle et al., 2006]. These 

diagrams include states, representing actions, transitions, which model conditions with the 
former components. However, the model does not present a standard set of concepts and may 

lead to the developing of very specific strategies. Later, the team used the concept of dynamic 

role assignment [Zweigle et al., 2008], where the role allocation is done locally by every robot, 
based on the information of the shared world model. If there are inconsistencies in the world 

model, the role assignment would be potentially wrong. 

TechUnited [Aangenent et al., 2009] and the Brainstormers Tribots [Lange et al., 2008] 

uses a similar approach related to roles. A centrally and dedicated module is responsible to 
dynamically select the best play to use in a given moment, based on world-state, namely player 

and ball positions. 

2.3.4 Set-plays 

A set-play – or studied play – can be defined as a pre-defined plan which is executed in a 

series of steps, involving two or more participants. All the participants have full understanding 
of all the existing steps and what they need to do in each one of them. This concept is widely 

used in sports such as soccer, rugby, handball, basketball and baseball. In soccer it can be easier 

to detect its use in free kicks or corners. Set-plays can be understood as multi-agent small plans 

that need the commitment of several players in order to reach a common goal. 
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The concept of set-play is presented by Stone and Veloso [Stone and Veloso, 1999]. These 

set-plays, however, are only mean to be used in specific situations like corner kicks and throw-
ins, thus the question of set-play activation and choice is not considered. Also, a set-play is 

limited to a sequence of steps, without alternatives, which excludes the need of choice 

announcing, and therefore the use of communication. 
An interesting approach is presented in [Castelpietra et al., 2002], where set-plays are 

represented as transition graphs. These plans have high level of abstraction, and can be applied 

to different robotic platforms. How the robots deal with synchronisation and the actual 

execution of the plans remains unclear. Another example of abstraction [Iocchi et al., 2007] was 
when Petri Nets were used to structure the development of a join team from two distinct 

institutions. 

[Rad et al., 2004] use a tree of plan sequences to choose the best suited plan in each 
situation, being permanently re-evaluated. The mechanism for synchronization, a vital issue, is 

not clearly described. 

Mota and Reis [Mota and Reis, 2007] defined the underlying concepts of set-plays, by 

developing a framework in a league independent way, specifying the language definition of a 
set-play and explained all the concepts involved in its execution. As we can see in the Figure 

2.12 and Figure 2.13, a set-play is identified by a name, and has parameters, which can be 

simple data types like integers and decimals, or more sophisticated concepts as points and 
regions. Set-plays have also Player Reference, identifying the players taking part of the set-

play. Player Reference can point to a specific player or to a Player Role. Player Roles will be 

instantiated at run-time, allowing a flexible use of the set-play. A set-play is composed by 
several Steps, representing states, which have conditions – a set of necessary conditions to enter 

or leave a step. The players taking part of the set-play will follow these steps in order to 

accomplish the successful execution of the set-play. 

 

 
Figure 2.12 – Set-play definition [Mota and Reis, 2007] 

 
There are several possible ways out of a Step, which are defined as Transitions. All 

Transitions can have a Condition, which must be satisfied for the Transition to be followed 

[Mota and Reis, 2007]. Inside a Transition there are a number of Directives – actions to take - to 
be followed in order to accomplish the transition. 
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Figure 2.13 – Action definition [Mota and Reis, 2007] 

A directive indicates which Actions should the player do or don‟t do. Examples of such 

actions are: passing a ball to a player or region, shooting at goal, intercept the ball, or dribbling. 

The action concepts were inspired by the Clang language [Chen et al., 2003]. 

One relevant task in the concept of set-plays is how to appropriately select the best set-play 
to use in a given moment. In the approach presented in [Bowling et al., 2004], the success of 

Plays is recorded, in order to help the choice of these Plays in future execution opportunities. 

This evaluation can rapidly change, even during one game, to cope with Plays that ceased to be 
effective due to practical reasons like not being adapted to a specific team, or opponent 

adaptation to the Play. 

Lopes [Lopes, 2009], defined a graphical interface to easily design these set-plays, 

exporting the definition of the set-play in the same format defined in the Mota and Reis [Mota 
and Reis, 2007] work. 

2.3.5 Positional Coordination 

A method to achieve coordination based on repulsions and attractions called Strategic 

Positioning by Attraction and Repulsion (SPAR) was introduced by [Stone, 1998]. When using 

this kind of positioning, an agent maximizes the distance to other players and minimizes the 
distance to ball and to goal. It also takes in consideration the repulsion from opponents and team 

mates, attraction to active team mate, ball and opponent goal. It also uses some constraints like: 

stay within the field boundaries, avoid being at an offside position, among others. 
Later the Situation Based Strategic Positioning (SBSP) was introduced by [Reis et al, 

2001] [Lau and Reis, 2007]. It is based on dynamic formations and strategic positions for each 

player in the team. An appropriate Formation is activated according to the current Situation, 

determining the strategic position of every agent in the field. If an agent is not involved, and 
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will not be soon, in an active situation, it will try to occupy its strategic position relative to the 

actual situation of the game. This position is then adjusted accordingly to ball‟s position and 
velocity and situation (i.e. attack, defence, etc...). The player type defines player‟s strategic 

characteristics like ball attraction, admissible regions in the field, tendency to stay behind the 

ball, alignment in the offside line, and attraction by specific points in the field in some 
situations. Due to the better performance than SPAR, SBSP was adopted by several teams as the 

standard positioning method. The CAMBADA coordination model [Lau et al., 2008] is based 

on similar SBSP strategies used in RoboCup 2D Simulation League, adapted to the Middle-Size 

league specifications. 
HELIOS proposed a Triangulation based Positioning Mechanism, a function 

representation model to define a team formation, which utilized Delaunay Triangulation and a 

linear interpolation algorithm [Akiyama et al., 2007] [Akiyama and Noda, 2008]. The main idea 
is similar to SBSP, with the definition of player‟s strategic characteristics and formations 

accordingly to the position of the ball, being able to determine the best strategic position for a 

player in a given moment. This method proved to be more effective than SBSP [Lopes, 2009]. 

2.3.6 Coordination Methodologies in FC Portugal 

The main coordination methodologies applied to the 2D Simulation team, at the current 

time, are [Reis, 2003]:  

 Advanced Communication. A framework to coordinate the team through the use of 

communication. Only the most useful information to the team is transmitted in a given 

instant. It is based on the creation of a separate world state using only information from 

teammates. The comparison between the player‟s communicated and perceived worlds 
allows him to assess the interest of each item of his perceived world state to his 

teammates and select the most useful information to transmit. 

 Strategic Looking Mechanism. An approach based on the smart usage of sensors by a 

player. At each instant, depending on the situation of the game and the information 
available of the world, each player looks at a strategic location to improve the world's 

state accuracy and maximize the chance for success of cooperative actions with 

teammates. 

 Mutual Modelling. An agent creates a model of every other agent in the team, thus 

allowing it to predict their actions, namely the player‟s position. If there is no visual or 
hearing information about a player‟s position and there is low confidence on the past 

information, his actions to move towards his strategic position can be predicted. 

 Dynamic Positioning and Role Exchange. A methodology for the exchange of roles 

and positioning for heterogeneous players based on the concept of utility. In the start of 
a game, every player is assigned a strategic position and certain behaviour. However, 

there are some situations in a game where an exchange of roles can benefit the team 

coordination. The concept of utility is based on the distance of the positions of the 
players, adequacy to the role and the position value. 

 Coach instruction and strategy communication. With a global and error free 

perception of the world and no time constraints, the coach spends his time analysing the 

performance of the team and the opponent. He decides the best strategy to use in every 

instant, making adjustment to the team‟s formations and roles, transmitting his 
decisions to the players with the use of communication. 

 High level positioning. This method uses Delaunay Triangulation and a linear 

interpolation algorithm to determine the best strategic position for a player in a given 

moment. It is based on the definition of player‟s strategic characteristics and formations 
accordingly to the position of the ball. 

 Analysis and prediction of the opponent formation. Almeida [Almeida, 2008] 

developed a methodology of classification in order to identify formations used by a 
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team in a given game by the use of Data Mining techniques. This is extremely useful for 

identifying an opponent‟s formation during game. 

2.4 Conclusion 

The RoboCup initiative has stimulated research in the artificial intelligence field. In the 

last ten years, the RoboCup competitions have increasingly become a test bed for co-operative 

robotic approaches. Also, the growth number of participants and attendants indicates that has 
turned media and crowd attention to it, mainly for the fact that soccer emerged as the most 

popular team sport. 

Nowadays, to better deal with this diversity of challenges, RoboCup has been split in 
different and heterogeneous leagues. This diversity allowed research teams to deal with a broad 

of scientific issues. However, it also brought some setbacks: the increase focus in specific 

leagues and problems, overspecialization, neglecting the benefits from generalisation and wide 
application. This leads to solutions developed in one league that are not easily applicable in 

other leagues. Also the competitive nature of competitions can also be a factor not to share 

research, which can be supported by the fact that some teams do not release their source code 

after the competitions. 
Fortunately general frameworks are being target of more investigation. The concept of set-

plays have been used by several teams, although it‟s mainly used in very specific situations in 

the game like corners, free kicks, throw-ins, etc. Mota and Reis [Mota and Reis, 2007] proposed 
a generic framework that could be used as the main coordination methodology of a team using 

the concepts of set-plays, which could encourage the application in other leagues/domains and 

being a possible solution of mixed teams. 
From this review, one can conclude that there is the need for general purpose tools and 

frameworks that can apply to several leagues, facilitating the sharing of obtained solutions. 
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3 Base Code Study 

Since the team FC Portugal will be used throughout this thesis, it is important to analyse its 
current status. In order to be more competitive, it was needed to improve some low-level skills 

and the modelling of the state of the world. Also, its source code wasn‟t structured and 

organized as it should be, making it harder to implement set-plays or any new coordination 

methodology in these conditions. 
Fortunately, there is some willing to share knowledge and research in RoboCup. Some 

teams share their base code – a smaller, but functional, representation of the team, with a limited 

strategy, but with some well defined skills. It provides an excellent starting point for new teams. 
Two of the teams which released a base code were Helios and WrightEagle, curiously the 

two finalists of the last World RoboCup in Graz, Austria. The objective was to determine which 

base code was better in order to work on top of it, if it seemed worthwhile. Then, we could 
integrate the key high-level methodologies presented in the FC Portugal and latter the set-plays. 

In order to evaluate which base code is better there are some tests and studies that have to 

be made. First, it is important to evaluate the structure and organization of the code, ease to 

modification and understanding, which functionalities are implemented, and the performance of 
the team in several situations. To test the performance of the teams it was necessary to 

implement different strategies in each code and compare the results. To have another mean of 

comparison, the FC Portugal team would also suffer from modifications in order to play 
accordingly to the defined strategy. A full representation – binary - of a medium quality team – 

AmoyNQ – from 2008, was also introduced in the tests, helping taking conclusions. 

3.1 Structure of the Base Codes 

In the development of this work it was used the latest versions of the released code at that 
time. Helios base code version used was agent2d-2.1.0 including its library librcsc-3.1.1. For the 

WrightEagle team it was used the version WrightEagleBASE-13.2.2.1. 

3.1.1 WrightEagle 

WrightEagle base code is implemented in C++. First it will be described the general 
structure of the code. 
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The team players are defined in the Player class, descendent of the Client class. This class 
has the Run() method, that is executed cyclically, simulating the real player’s behaviour. The 
perceptions received update the current state of the world and it’s chosen the best behaviour to 
execute at the given moment. 

Those behaviours are chosen in the Decision() method defined in the DecisionTree class, 
which contains the decision module of the team. The behaviours are divided in four categories: 
defensive, attacking, positional and penalty. 

 

 
Figure 3.1 - Decision module of the WrightEagle base code 

 
In each class, illustrated in Figure 3.1, is executed the Plan() method that, considering a 

number of restrictions, returns the best behaviour with more utility for the player in that 
moment. All those behaviours, in each category, are kept in a list, and through the method 
GestBestActiveBehavior() the best one is chosen. 

Some relevant classes that helped in the implementation of the different strategies are 
described: 

 
 WorldState information about the state of the world and messages exchanged by 

players; 

 BallState information about the ball position, direction and velocity; 

 PlayerState information about the players (position, direction of the body and neck, 

detect collisions, etc.); 

 PositionInfo information about the positioning of all players and the ball, methods to 

see which players are closer to the ball or a specific player, which player has the ball, 

etc; 

 InterceptInfo useful information about possible interceptions; 

 Strategy contains some predictions of the current state of the game; 
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 Formation indicated which positioning the players should use in the field. 

 
Basic Functionalities 

 
The WrightEagle base code doesn’t have many implemented functionalities, thus the 

strategy is very limited. The initial formation, 4-3-3, plays in a very compact way concentrating 
a huge number of players in the middle of the field, allowing other teams who play preferably 
towards the wings have a lot of space. Another characteristic is that the players concentrate too 
much on the ball and less on the opponent; the defenders positioning don’t regard the opponent 
striker’s positions. 

The vision of the players is very simple: look at the ball or search it if it’s not in the vision 
radar. There’s no implemented function to calculate the best pass or offensive action. The 
players, when in possession of the ball, only shoot the opponent’s goal. No dribble function in 
the direction of the opponent’s goal is implemented either. 

3.1.2 Helios 

The Helios base code is written in C++. It is divided in two parts: a high-level decision 
module - agent2d-2.1.0 – and a library for the low-level skills – librcsc-3.1.1. 

 

 
Figure 3.2 - Helios base code structural division 

 

Some relevant classes that helped in the implementation of the different strategies are 
described: 

 

 PlayerAgent communication between client and server, information about agent 

sensors and server parameters; 

 ActionEffector information about agent sensors (body, vision, stamina, hearing, etc.); 

 WorldModel contains information about the state of the world and useful functions 

about the positioning of the players; 

 InterceptTable contains information about possible interceptions; 

 Librcsc-3,1,1/rcsc/action several classes containing the implementation of low-level 

skills like dribble, pass, shoot, vision, among others; 

 SamplePlayer contains the decision module of the player (actionImpl()). Updates the 

strategy, formations, and chooses the best behaviour in each situation; 

 Strategy defines formations and roles; 

 Role_ set of classes that have the definition of the different roles; 



Base Code Study 

 28 

 Behaviour_ set of classes that define the behaviour of a player in a given situation. 

 

The decision module of the team can be found in the following figure. 

 

 
Figure 3.3 – Decision module of the Helios base code 

 

Basic Functionalities 

 
Helios base code possesses already a vast number of implemented functionalities. The 

team has all the low-level skills implemented and presents a well defined strategy. 

There are several possible formations definition methodologies in this base code. The 
default one is based on the Delaunay Triangulation, where a number of special positions are 

defined for each player according to a ball position so that it can be predicted which position the 

player should occupy in each moment.  SPAR and also SBSP methods are available, where it‟s 
defined the attraction and repulsion for the ball by each player. For each type of positioning, 

there are different formations defined for various game situations. 

Each player has a role in the field. For each role there is the possibility to define specific 

behaviours, although what is defined is mainly the filter between two behaviours: decision with 
ball (progress in the field, pass, shoot, etc.) and decision without ball (intercept, tackle, move to 

strategic position, etc.). 

The vision of the player seems complete in the way that not only looks for the ball but also 
has the concern to know where his teammates and opponents are. Also, there is a function to 

analyse the best target for a pass or a shot on goal. While dribbling, the player tries to keep the 

ball the farthest possible from his opponents. 

3.2 Modifications 

The modification in each code focused mainly in the decision module of the team, when 

having the possession of the ball. Mainly all modifications were based on selecting the best 

action in a given moment: whether it would be a pass to a teammate, dribbling to the opponent‟s 
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goal, or shooting to the net. In case of a pass it was used the functions available in the code to 

determine the positions of the teammates, thus selecting one according to the test specification. 
Some modifications were needed though, to make the tests fairest possible, like disabling 

the dynamic change of roles in FC Portugal or communication in passes on the Helios base 

code. 

3.3 Performance Tests 

Next it will presented a series of tests in order to measure the performance of each base 

code in various situations of the game and using different strategies. 

All the teams – except the binary - will play under the same conditions, with the necessary 
changes in the code. It is important to mention, though, that it‟s very difficult to assure that the 

conditions are exactly identical, but it will not affect severely the results.  In some tests (mainly 

in the different kind of passes and dribbling) there aren‟t any keepers in order to the scoreboard 
indicate somehow which team had more accuracy in their passes and reach the goal more 

frequently. 

Other purposes of these tests are to evaluate the performance of various functionalities like 

the modelling of the state of the world, positioning, precision of the passes and shots. The tests 
were conducted using the version 13.2.2 of the rcssserver. The results of the tests are depicted in 

the following table and represent an average of 5 games. 

 
Table 3.1 - Base code performance tests results for different situations 

Test 

Description 

FCP 

vs 

Helios 

FCP 

vs 

WE 

FCP 

vs 

AmoyNQ 

WE 

vs 

Helios 

WE 

vs 

AmoyNQ 

Helios 

vs 

AmoyNQ 

Discussion 

without any 
modifications 

(evaluate initial 

strategy) 

2-1 16-0 3-1 0-10 0-8 3-1 

Considering that the initial strategy of the 
WrightEagle was very limited, it‟s 
normal the loss in all the games. The fact 
that the keeper left his position a lot of 
times also hurt the outcomes. 
Helios has a well defined strategy, been 

able to dispute the games with FC 
Portugal and AmoyNQ – which on this 
test represented a fully developed team - 
revealing promising results. 

short passes 2-5 12-2 3-5 3-14 1-20 3-6 

Looking at the results, a little 
improvement happened in the 
WrightEagle team, considering there 
weren‟t any keepers; the number of goals 

suffered wasn‟t very high and still 
managing to score goals. It was clear in 
this test that the poor vision decision of 
this team affected the precision of the 
passes.  
Helios had some interesting results, a 
victory against AmoyNQ – which is a 
binary with a well defined strategy. Even 

loosing the ball many times in the 
defence, due to the simplicity of this test 
passing rules, the defence made a solid 
performance.  
FC Portugal also did well, even though 
its strategy was completed changed, but 
against Helios the performance wasn‟t 
very good. Some inaccuracies were 

detected in some functions of the code – 
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due to its own structure - that may have 
influenced the results. 

short passes in 

our midfield, 
long passes in 
their midfield 

2-2 8-3 4-5 1-10 3-16 3-6 

In general, all the teams presented 
improvements on their performance. The 

new strategy allowed a slight progress in 
the field, creating more spaces between 
the players. However, it was clear that 
this progress isn‟t enough, thus the 
players keep concentrating themselves in 
the midfield. 
The WrightEagle team presented a slight 
improvement, but keeps suffering many 

goals due to his defensive line 
positioning (high on field). Helios and 
FC Portugal kept the same performance. 

deep passes 4-1 15-2 3-6 6-8 2-16 5-9 

The use of deep passes in this test was to 
give more offensive power to the teams. 
WrightEagle presented another 
significant improvement, managing to 

win one game against Helios. Also, the 
power of the shot of WrightEagle being 
stronger than Helios had a real impact on 
the result. 
A possible improvement in this test was 
to consider the angle of the deep passes 
to be proportional to the player‟s 
distance. 

dribbling 
without passing 

2-3 - 0-8 - - 7-7 

The WrightEagle didn‟t take part of this 
test because there was no dribble 
implemented. Helios presented very 
satisfactory results, disputing the game in 
equal terms with AmoyNQ, only with the 
use of the dribble. 
Despite the results, it cannot be said that 
FC Portugal has a bad dribble, on the 

contrary, but doesn‟t dribble too often in 
the direction of the opponent‟s goal. 

dribbling with 
passing 

1-3 - 4-8 - - 4-6 

The WrightEagle didn‟t take part of this 
test because there was no dribble 
implemented. In this test the teams used a 
strategy closer to reality. The games were 
more enjoyable and richer, with more 
fights for the possession of the ball. The 

fact that the total number of goals 
decreased since the last test is due to the 
players less attempt to dribble in 
dangerous situations like in the defence. 
Despite committing fewer errors in the 
defence, Helios had more difficulties to 
create goal opportunities. 

Defence - - 0-4 - 0-12 0-6 

Looking at the results, it is obvious that 
WrightEagle has the worst defence. The 
defence line is often badly positioned in 
the field not concerning the opponent‟s 
positions. 
Helios presented an organized defence, 
covering well the spaces and marking 
well the opponents. FC Portugal had the 
best defence, but considering that is not a 

base code, Helios did pretty well. 

shot accuracy 
(% of hitting the 

post from a 
closer and 

FCP: 75% were near from closer distance. 35% from distant. 

WE: 75% were near from closer distance. 65% from distant. 
HE: 70% were near from closer distance. 55% from distant. 

In general, WrightEagle is the most 
accurate team. In closer distance FC 
Portugal has the same accuracy, though 
more disparity is seen in a farthest place. 
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distant position. 
20 shots from 
each position) 

Penalties FCPortugal vs Helios: 4-0 

Analyzing the results, the FC Portugal 

smashed Helios in the penalty kicks. FC 
Portugal players tend to discover an open 
space and shot immediately, while Helios 
players try to dribble the keeper. 
However, a special note has to be given: 
FC Portugal keeper is known to be 
amazingly good in defending penalty 
kicks. 

3.4 Discussion 

3.4.1 Structure and ease of modification 

Considering the complexity of a study of this kind, it can be said that on a structure level, 

both codes seem well structured and comprehensible, facilitating the modification of the 

decision module in order to fully implement the tests described before. The name of the 

classes/methods seems to make a good description of what are intended to do and there also 
some helping comments on the code, in English, demonstrating a well logic organization of the 

code. 

The decision module is common to all players making it easier to change the team strategy. 
The easiness of modification is clear, since there wasn‟t any severe trouble in the 

implementation of the different tests. After a further analysis of both codes, due to the 

dependency of modules/classes/variables it‟s not possible to remove a module and expect it to 
work on a different code. However, due to the ease of understanding of both codes, it‟s easier to 

extract the main ideas from it. 

3.4.2 Functionalities Review 

Not only it is important to test the performance of the base codes in general, but also it is 

important to review, at some extent, each of the functionality available. In the following table 

some of the key functionalities that a soccer simulation team must deal with are presented. The 
terms of comparison are not only between each of the base codes but also with the FC Portugal 

team in order to evaluate if some of the functionalities should be considered in the latter. 

 
Table 3.2 - Base code functionalities review 

 WrightEagle Helios 

World state modeling 

Unfortunately there was no time to really explore this functionality 

and to measure the precise quality of the world state modelled. 
However, it can be assumed that one of the good things that a base 

code has is the world state modelling: how the player manages the 

information retrieved from his vision and shares among his 

teammates, where he predicts his teammates and opponents will be, 

etc. 

Vision strategy 

The vision strategy in this base 

code is very limited: the player 

only concentrates his neck on the 

ball which leads to a less 

accurate world state. 

A more complex vision strategy 

is presented in this base code. 

The players try to look for the 

ball, updating other player‟s 

position meanwhile. 

Low-level skills (tackle, dribble, Here we can see that most of the On the contrary, all the low-level 
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movement, shoot, etc) low-level skills were not 

implemented in the base code. 

There is no dribbling, tackling 

nor choosing the best place to 

shoot at the goal. Not even a 

simple passing function is 

implemented. However, one 
interesting thing is the accuracy 

and powerfulness of the shots: 

the players try to speed up the 

ball first before they perform 

their shot. 

skills are implemented here. It 

cannot be said that they are top 

level but at least they are 

somehow robust and will fit for 

the majority of the teams. 

Positioning 

The positioning mechanism is 

based on SBSP which was 

explained before. Some teams 

continue to successfully use this 

kind of positioning. 

This base code allows the option 

to choose between different 

kinds of positioning. Some of 

them are: Delaunay 

Triangulation (default), SBSP, 

SPAR, BPN, NGNET, among 

others. 

Action selection mechanism 

Basically there isn‟t any action 

selection mechanism. The 

players try to intercept the ball 

and when in possession of the 

ball he shoots at the centre of the 

goal (no matter where he is on 

the field). There is no passing 

involving teammates. 

A more robust action selection 
mechanism is present here. If a 

player is not in possession of the 

ball he tries to intercept the ball 

(if he‟s near) or he moves to his 

strategic position (defined in the 

formation). When in possession 

of the ball there are a couple of 

different actions that a player 

can take (dribble, different kind 

of passes, shooting, etc). 

However, these actions are based 
on a series of „if‟ conditions 

making it somehow a hard-coded 

strategy. One interesting thing is 

that the players communicate 

their passing decisions. 

Released software  

A special note has to be given to 

the Helios team. Some tools like 

soccerwindow2 (viewer 

program for rcss, log player and 

visual debugger) and fedit 

(formation editor using human‟s 

intuitive operations) proven to 

be very helpful. 

 

3.5 Conclusion 

Having in mind that the main goal was to compare the performance between two base 

codes – WrightEagle and Helios – analysing the results it is clear that Helios is the team with 
the best base code. Helios was stronger than WrightEagle in almost every test that was 

conducted. WrightEagle presented some flaws in defence, positioning and vision, and lack some 

low-level skills which compromised severely the choice. Helios, on the other hand, had all the 
low-levels skills implemented, which can save a lot of work in comparison of what would be 

needed to fix the WrighEagle base code. The choice for the Helios base code is clearly the best 
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option for a starting team who‟s more interested in developing high-level methodologies than 

low-level skills. However, for an existing team, WrightEagle base code also has some 
interesting features like the world state modelling or the shooting skill. 

After selecting the best base code, it was clear that the base code itself wasn‟t as 

competitive as the FC Portugal team. So, there were two options: implement some of the 
coordination methodologies of FC Portugal in the base code or try to integrate both codes into a 

single one. The first option required a lot of effort since there were too many features that had to 

be implemented (defence strategy, dribble, keeper, DPRE, among others). The second option 

was chosen and the integration of both codes was started. At some point, a mixed team between 
Helios base code and FC Portugal was implemented: all the functionalities available in each 

code were available to all but some aspects were still team-dependent. For example, the world 

state modelling depended on the type of communication‟s message each team used and only one 
of the teams could communicate per cycle. So, if the world states were different, both decision 

mechanisms were based on different inputs and there wasn‟t any obvious advantage of the 

integration. At this point it was possible, however, to do some interesting things like alternating 

the action selection mechanism between the two codes at different times or have the keeper (or 
any other player) having his decisions based on the FC Portugal team code and the rest of the 

team based on the Helios code. Meanwhile, the set-play framework was starting to be 

implemented in this integration, on the Helios part of the code. 
During the German Open 2010 competition, it was used solely the FC Portugal team code 

because the integration wasn‟t mature enough. It was realized that the team even though it was 

based on features that hadn‟t been changed for a lot of years, it was still competitive. Since the 
team was participating in the next competition in three different leagues (2D, 3D and Mixed-

Reality) it was believed that it would be a good idea to have a common strategy that all the 

leagues could take advantage of. This new strategy would be a new action selection mechanism 

when in possession of the ball and it would be based on generic concepts like flux, safe and 
easiness in order to know which place it is better to send the ball to. So, the focus had been 

changed and generic coordination methodologies were the main concern in order to be used 

among all the leagues. In the next chapter the new strategy - and other features - will be 
explained in more detail. The integration with the base code was no longer used since it wasn‟t 

mature enough. However, the FC Portugal team code would have to suffer some changes in 

order to adopt the new strategy. In concern of the set-play framework, there was a previous 
implementation in the FC Portugal team which would still be used. 
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4 Matchflow 

In this year‟s RoboCup competition, FC Portugal was going to participate in three different 

leagues. Besides the 2D Simulation league, the team was also participating in the 3D Simulation 
league and in the Mixed-Reality league. The 2D Simulation league represented the source of all 

the developed high-level coordination methodologies among the years but the others leagues 

were starting to take off and could also benefit from using them. The idea was to easily integrate 

in other leagues the key high-level coordination methodologies that had been used in the 2D 
league. However, the idea didn‟t stop there. 

What could really benefit all the leagues would be having a common strategy based on 

generic concepts that could be applied to the different leagues. A new decision module when in 
possession of the ball was thought by the team leaders based on three concepts: flux, safety and 

easiness. The goal was to evaluate the best position to send the ball to in the next cycle, a 

common problem in soccer simulation. Besides this new strategy, the formation mechanisms 

used in the 2D league (SBSP and Delaunay Triangulation) were meant to be used also in all 
other leagues but needed some revising. This work is based on improving the concept of 

positional co-ordination by using a more robust formation mechanism and developing the 

necessary tools to facilitate the definition of those formations and to accommodate also the 
concepts presented in the new decision module. The result was a graphical tool named 

Matchflow, based on an existing one, meant to be generic enough to be used in several leagues, 

allowing the definition of advanced formations and game flow. 

4.1 Triangulation based Positioning Mechanism 

4.1.1 Delaunay Triangulation and Linear Interpolation 

The Triangulation based Positioning Mechanism is a function representation model to 

define a team formation, which utilized Delaunay Triangulation and a linear interpolation 

algorithm [Akiyama et al., 2007] [Akiyama and Noda, 2008]. The main idea is similar to SBSP, 
with the definition of player‟s strategic characteristics and formations, being able to determine 

the best strategic position for a player in a given moment. 

An input value of the mechanism is a focal point on the soccer field, usually the ball 
position. The output values are agents’ strategic positions according to the input value. The 
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soccer field is divided into several triangles according to given data. The Delaunay triangulation 
is used to find the triangle to which the new ball position is inserted. Then, a linear interpolation 
algorithm is used to calculate the player position. 

Initially, when defining a new formation, a point is required to create the initial triangle. In 
each vertex of the triangle we can define the players’ strategic positions for that point. Each 
time a point is added, it finds the triangle in the triangulation that surrounds it, and edges from 
this point to the vertices of its surrounded triangle are added. If it falls on an edge, edges for the 
opposite edges of the two triangles are added. In Figure 4.1 are visible the two case scenarios 
when a vertex Pr is added. 

 

 
Figure 4.1 – Vertex added inside and lying on an edge of a triangle [Kreveld et al. 2000] 

Delaunay Triangulation maximizes the minimum angle of all the angles of the triangles in 
the triangulation, getting the most stable triangles from Delaunay Triangulation. When all edges 

of the triangles are legal, it is not possible to increase the minimum angle, the triangulation is 

angle-optimal therefore a Delaunay triangulation [Kreveld et al. 2000]. For calculating the 
Delaunay Triangulation, it was used an incremental algorithm, one of the fastest. 

There is a duality between the Delaunay triangulation and the Voronoy diagram. If the 

centre of the circumcircles of the triangulation is connected, it results in the Voronoy diagram 

for that set of points. 
After having all the triangles defined, it is used a linear interpolation algorithm to calculate 

the strategic positions of the players in the formation. In this model, one training data is 

corresponding to one vertex in the triangulation. So, each vertex has a ball position as an input 
value and has agents‟ positions according to the vertex (ball) position as output values. When an 

unknown input value is given, output values are calculated by Gouraud shading algorithm 

[GOURAUD, 2008]. Gouraud shading algorithm is a method used in computer graphics domain 

to simulate the differing effects of light and color across the surface of an object. 

 

 
Figure 4.2 - Delaunay Triangulation and Linear Interpolation [Akiyama et al, 2009] 
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The Figure 4.2(b) shows the process involved in the algorithm. 𝑷𝒂, 𝑷𝒃 and 𝑷𝒄 are the 

vertices of the triangle and represent ball positions. The output values from vertices are 𝑶 𝑷𝒂 , 
𝑶 𝑷𝒃  and 𝑶(𝑷𝒄) respectively, representing the player strategic position in that ball position. 

Now, we want to calculate 𝑶 𝑩 , the output value of the point B contained by the triangle 

𝑷𝒂𝑷𝒃𝑷𝒄 .The algorithm is as follows: 

 

1. Calculates 𝑰, the intersection point of the segment 𝑷𝒃𝑷𝒄 and the line 𝑷𝒂𝑩. 

2. The output value at 𝑰, 𝑶 𝑰 , is calculated as: 

𝑶 𝑰 = 𝑶 𝑷𝒃 + 
 𝑶 𝑷𝒄 −  𝑶 𝑷𝒃    𝑷𝒃𝑰         

 𝑷𝒃𝑰         +  𝑷𝒄𝑰        
 

 

3. 𝑶 𝑩  is calculated as: 

𝑶 𝑩 = 𝑶 𝑷𝒂 + 
 𝑶 𝑰 −  𝑶 𝑷𝒂    𝑷𝒂𝑩          

 𝑷𝒂𝑩          +   𝑩𝑰       
 

 

Using the above interpolation algorithm, if a certain triangle in the triangulation contains 
an unknown input value (ball position), output values (agents’ positions) can be calculated 
according to the vertices of the triangle [HELIOS, 2009]. 

4.1.2 Formation Analysis 

One of the earliest criticisms about this type of formation, in our opinion, regarded the fact 
that it depended solely on the position of the ball. In real soccer it is obvious that each situation 
is analysed having in consideration a lot of information that would be hard to consider here. 
However, we believe that some concepts must be addressed, for instance there is a big 
difference when a team has the ball and when it hasn’t: the players should adapt their positions 
to these two distinct situations. 

The first approach to this problem was to define two distinct formations, one for each 
situation; when in possession of the ball the team would use an attacking formation and when 
not in possession of the ball the players would adopt a defensive formation. First, this required 
an algorithm to determine if the team had the ball or not. Secondly, some amount of effort to 
define two complete formations, although similar, because the changes between defending and 
attacking were mainly based on pushing the players backward/forward. 

The result of this approach was promising but required too much effort defining the 
formations and was more prone to errors since there were a lot of parts of the formations that 
didn’t needed to be redefined, however, the same information would be present in two different 
places, making it harder to maintain. Still, the main problem hadn’t been solved. The formation 
was still very dependent on the ball position and didn’t adapt concerning the player who had the 
ball. This could be easily noticed by the frequent collisions that our teammates suffered 
especially when one of our players started to dribble in the direction of other’s teammate 
strategic position. What should had happened is the player adapt his position considering the 
teammate who had the ball in order not to disturb his own teammate and create a line of pass. 

Having all this in consideration a graphical tool was developed that was able to define, in a 
single formation, the players positions for when not in possession of the ball and the necessary 
adjustments when in possession. Those adjustments are so precise since they depend on which 
of our players have the ball and the place on the field. The only requirement for each league is 
an algorithm to determine which player is considered to be in possession of the ball (if any). 
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4.1.3 Formation Editing Tool 

HELIOS team has developed a team formation editing tool, as part of soccerwindow2. fedit 
enables us to intuitively compose desired agents’ positions according to the ball position. This 
tool had been developed specially for the 2D Simulation league but in this work it was extended 
to the 3D and Mixed-Reality leagues. Some of those changes regarded the dimensions of the 
field, number of players, among others. Besides this extension, it was also added the possibility 
of redefine some (or all) the players’ positions for each one of our players who had the 
possession of the ball. This allowed the definition, in a single formation, of the players’ 
positions for when not in possession of the ball and the necessary adjustments when in 
possession, with a lot of precision since it depended on the player who had the ball. 

 

 
Figure 4.3 - Matchflow initial formation creation screen 

In the above picture we can see the initial screen for the formation creation process. The 
user is asked to select the appropriate league in order to adapt the dimensions of the field and 

the number of players. At this moment, three different leagues can be chosen: 2D, 3D and 

Mixed-Reality league. 
One of the interesting features that this tool already had was the Symmetry Option since it 

allowed the definition of symmetry between players in the field. In Figure 4.4 we can see that 

the players have distinct colours (yellow and green) separated by the horizontal line in the 

centre of the field. We can define manually which players have symmetry but generally 
symmetric players are the ones who have the same role in opposite positions in the field (left 

and right central defenders, left and right wingers, etc...). This saves us a lot of work since any 

change in one side of the field, will reflect the same changes in the opposite side with the 
respective symmetry. With this option turned on we just need to define the players positions in 

one side of the field (divided horizontally) and those changes will reflect also in the other. In 

Figure 4.5 we can have a confirmation of the symmetry of the players via Edit Box, being 0 the 
ones who don‟t have symmetry, -1 the players who have symmetry with another player and the 

others having the symmetry player number associated. Of course, the players who don‟t have 

any symmetry player associated (like player 6) have symmetry with themselves, meaning every 

change in one side of the field will also be reflected in the opposite side. 
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Figure 4.4 - Overview of a formation' triangulation 

For defining the players‟ positions in a region of the field, we move the ball to the nearest 

vertex, change the position of some players and then use the Replace option to save the 
changes. If we want to delete a vertex we can do that by clicking in the Delete option after 

selecting the respective vertex. When we are satisfied with the formation we defined, we 

conclude the process by selecting the Save formation option. 

 

 

Figure 4.5 - Symmetry between players and Edit Box to give more precision to players' positions 

Next, it was introduced the concept of player with ball possession. The normal formation 

would be now the formation when not in possession of the ball (being Player in Possession 
considered 0 - the opponent). After adjusting the players‟ position for this situation, we can start 

to define our attack formation by adjusting some of the players‟ positions in the attack for each 

one of our midfielders and attackers. The Figure 4.6 shows the initial screen when selecting a 
player considered to be in possession of the ball. This player can be selected in the appropriate 

spin box available in the menu bar. 
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Figure 4.6 - Initial formation screen for a player considered to be in possession of the ball 

As we can see in the above figure, every vertex number in the triangulation changed its 

colour to white and the player in possession of the ball (player 6) changed its colour to red. With 
this visual aid we can easily spot that we have entered in the player with ball possession editor 

mode and see where changes have been made. After entering this mode we continue to define 

the players‟ position in the same way as before, but now we know that for each ball position the 

player 6 has the ball, so we can adjust the positions of some of our players. When redefining a 
vertex, its colour will change to red, indicating that the vertex was redefined. The triangulation 

is the same, for reasons of consistency, but not every vertex will have the same output as before. 

Each vertex with number in white colour will output positions for when not in possession of the 
ball and the vertices with the number in red will output positions when in possession. So, in 

some cases there‟s a mix that is perfectly acceptable since we want to maintain most of the 

formation and only adjust some regions on the field. 
 

 
Figure 4.7 - Some redefined players' positions when player 10 is in possession of the ball 

Every player will have player in possession samples, which are a list of redefined vertices 

with the changes that have been made in comparison with the original definition (when not in 
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possession of the ball). In fact, only the players who had their position changed in that vertex 

are saved in these samples. This means that if we don‟t change some of the players‟ positions 

(for example the defence) this partial data will come always from the normal formation, 
becoming more flexible and less error prone. This also eliminates any kind of redundancy and 

saves a lot of space in the formation file definition, making it also easier to read and understand. 

Another interesting feature is that the Symmetry Option also makes sense when defining 

player with ball samples. For example, in Figure 4.7 we are changing the positions when player 
10 has the ball. With this option toggled on, the player 11 (symmetry player) will also suffer the 

same changes (with the necessary adaptations since it is in the opposite side of the field) which 

leads to another 50% reduction in the work it would be needed without this option. 

4.1.4 Internal Data Structure and Algorithms 

In Figure 4.8 it is presented a simplified view of the general data structure for the 
Matchflow application, focusing on the formation definition related classes. FEditData 
represents the class that holds the data concerned to the formation and triangulation. 
FEditDialog and FEditCanvas are classes that are more targeted to deal with the graphical 
interface issues. 

 

 

Figure 4.8 - Matchflow partial data structure diagram 

The formation data is saved in the M_samples variable which is a vector of the 
SampleData class. This is where the normal formation is saved, representing the formation 
when not in possession of the ball. The SampleData class holds the formation data for each of 
the vertices of the triangulation: index_ is the vertex number, ball_ is the position of the ball, 
players_ is a container with the positions of the players and flux_ represents the flux value for 
that vertex. 



Matchflow 

 42 

For the player in possession samples, an array of the same class was created for each of the 
players in the team, representing the changes in the formation that must be made if one of them 
is in possession of the ball. The same class was used for reasons of simplicity but some different 
attributes are used: index_ indicates the vertex number, players_ represent the modified players 
positions for that vertex and players_modified_ indicates which players have been modified. 

The general algorithm to obtain the strategic position for a given player in a formation, 
which was used in this tool and in the common framework for the various leagues, is presented: 

 
SBSPDelaunayPosition(formation, player, ballPos, playerWithBall)

Triangle = Triangulations[formation]->findTriangleContains(ballPos)

for each Vertex in Triangle
     determine playerPosition for each Vertex with PlayerPositions

if playerWithBall != 0
     for each SampleData in ChangedPositions[formation]
          if SampleData->ballOwner == playerWithBall
               for each Vertex in Triangle
                    if Vertex->Id == SampleData->VertexId 
                         for each ChangedPlayer in SampleData->changedPlayers
                              if ChangedPlayer == player
                                   replace playerPosition for Vertex with SampleData->playersPositions

RETURN interpolate(ballPos,
 BallPosition[formation][Triangle->Vertex(0)->Id],
 BallPosition[formation][Triangle->Vertex(1)->Id],
 BallPosition[formation][Triangle->Vertex(2)->Id],
 playerPositionVertex0,
 playerPositionVertex1,
 playerPositionVertex2)

 

4.1.5 Formation File Format 

After defining the formation it must be saved in a configuration file in order to be modified 
in the future and to the team be able to read it and use it in during the games. The formation is 
saved in a file with the “.conf” suffix. It stores the name of the league it’s meant for, the 
symmetry of the players and the positioning of the players in the formation (when not in 
possession and when in possession of the ball). The file format is as it follows: 

 



Matchflow 

 43 

Formation DelaunayTriangulation $l # Name of the league
Begin Roles
$pi $r $s # Player Number, Role Name, Symmetry Type
End Roles
Begin Samples $st $vn # Sample type version, Number of vertices
----- $v ----- # Vertex number
Ball $bx $by # Ball Position (X,Y)
$pi $pix $piy $ Player Number, Player Position (X,Y)
End Samples
Begin Player With Ball Samples $pn # Number of players with ball redefined
Player $p $vn # Player with ball number, Number of Vertices changed
$v $pc # Vertex Number, Number of positions changed
$p $px $py # Changed player number, Player new position (X,Y)
End Player With Ball Samples
End

 
This format is generic enough to be used in all the different leagues. First we mention the 

league it’s meant for, in order to adapt the field and the numbers of players in the tool, or to 
validate if it’s the correct file the team is reading. After that, the roles are described for the 
different players each league has (11 in 2D, 6 in 3D and 5 in Mixed-Reality) and the players’ 
symmetry type. Next for each vertex that is defined in the formation we refer the ball and 
players’ positions. These are the main samples of the formation, the ones who are considered 
when not in possession of the ball. Then, we tell how many players we considered to be in 
possession of the ball, and for each one, the number of vertices changed. For each vertex that 
was changed we mention how many players had their position changed in comparison to the 
main formation. For each one of those players we tell their respective number and the new 
position in the field. 

4.2 Defining a game flow 

After the analysis of several matches between different teams, it was obvious that certain 

aspects were worthwhile to explore, mainly: 

 Teams don‟t adapt their strategy to the opponents. The main reason for this is 

probably the lack of agility to do so in an easy and practical way. 

 Teams should reinforce actions that have lead to good results. This is not easy to 

do but even a simple mechanism for this would bring possible benefits. 

 The last point is especially true since most (or all of them) doesn‟t learn by their 

mistakes. 

So, if we could categorize an opponent in a certain type and we could define where our 
team should attack from, which places to avoid and other useful parameters depending on the 

type of an opponent, the performance of the team could easily improve and show more 

flexibility when facing new opponents by determining it‟s type and use the most appropriate 
strategy. 

4.2.1 Generic Strategy for different leagues 

As mentioned before, the new strategy is triggered when the player is in possession of the 
ball. He selects the best place to pass the ball to, considering three concepts: 
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 Flux – The flux represents the areas on the field that are more appealing to go to. 

Basically, the field is divided in zones and for each of those zones it‟s given a 

certain value indicating the worthiness of playing in that region of the field. Zones 

with higher flux values should be preferable than zones with lower flux. This 
determines the best place to pass the ball to regarding its current position. 

 Safety – The safety concept regards the trajectory that the ball must travel until it 

reaches its final destination. If there is one opponent (or more) that can intercept 

the ball before our teammates do, that indicates a low safety value for that action, 

meaning we should consider other action if possible. 

 Easiness – This concept is probably the one which is more league-dependent. It 

tries to measure the easiness of executing a given action. For example, a hard to 

execute action would be to have to turn around completely to face the ball and then 

shoot it to the corners of the field. This action is particularly more difficult in the 
3D Simulation league than in the 2D. 

Although this strategy is based on generic concepts it’s obvious that some of the 
evaluations must be league dependent. Not forgetting the idea to have a common and generic 
strategy, some parameters were introduced in the strategy file that would be tuned for each 
league. Some of those parameters are for example the velocity of the players and the maximum 
distance that a player can shoot. 

 

 
Figure 4.9 – Example of some of the possible pass points 

 

In practice, it is created a circle around the player with possible passing points. The amount 
of points depends on the size of the circle (maximum kick distance) and the number of divisions 
of the circle (angle). For every of those points it’s given a value that is calculated having in 
consideration the three concepts. Each concept has an appropriate weight, since it can vary on 
the type of opponent, and the point with the highest end value will be chosen, leaving the 
decision on how to execute the action (pass to that point) to the player. 

The formula is summarized here: 
 

𝑷𝑽 = 𝑾𝑭 ∗ 𝒇𝒍𝒖𝒙𝒗𝒂𝒍𝒖𝒆+ 𝑾𝑺 ∗ 𝒔𝒂𝒇𝒆𝒕𝒚𝒗𝒂𝒍𝒖𝒆 + 𝑾𝑬 ∗ 𝒆𝒂𝒔𝒊𝒏𝒆𝒔𝒔𝒗𝒂𝒍𝒖𝒆 
 
...being WF the weight of the flux, WF the weight of the safety and WE the weight for the 

easiness. The fluxvalue represents the gain in the flux that the final destination will bring in 
comparison to the current ball position. 

With these parameters it is possible to easily tune our strategy having in consideration the 
opponent. In short, we can control the parameters for the flux, safety and easiness and also the 
zones in the field with higher/lower flux values. The parameters can be easily changed but the 
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flux, which was defined via a matrix of values, could benefit from an easier and intuitive way 
for its definition. Also, by using a matrix of flux values we lack some precision. This precision 
is very important since we wanted to extend the concept of flux to other situations like 
dribbling: the player in possession of the ball if he decided to dribble, he would do it in the 
direction of the flux’s growth. 

The solution was to take advantage of the formation graphical tool and add it there flux 
values for every vertex in the formation. This allowed us to define flux using an existing 
formation or developing a new formation, with the vertices we wanted, just for the definition of 
the flux. This allowed using the Delaunay Triangulation mechanism also for calculating the flux 
for a given point in the field, giving us the precision we wanted in the first place. Moreover, this 
interface provides the necessary tools to facilitate the definition and modification of the flux. 

4.2.2 Flux Editing Tool 

Another extension in the formation editing tool was the possibility of defining flux values 
for regions in the field. We took advantage of the Delaunay Triangulation for creating the 
different triangles in the field, assigned a flux value for each vertex of the triangles and 
calculated the flux value for a given point considering the vertices of the respective triangle 
using the same linear interpolation algorithm that was described before. 

 

 
Figure 4.10 - Delaunay Triangulation for the definition of the flux values 

In Figure 4.10 we can see that a special triangulation was defined in a way that resembles a 
matrix. However, as we can see in the figure, not all the squares have the same size, which mean 
that we can control the precision we want in any region of the field. Actually, we didn’t need to 
define a new triangulation for defining flux values; we can use the formation’s triangulation and 
define flux values for each vertex available. Also, unlike a matrix that have the same flux value 
for a region, with the linear interpolation algorithm we can have different flux values between 
the vertices of each triangle, generating a smoother flux changes between regions of the field. 
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Figure 4.11 - Flux values for different regions in the field and flux interpolation 

For assigning a flux value for a given vertex, we have to toggle first the Show Flux option 

which will hide the triangulation and show the flux values for each vertex. Initially all vertices 
have zero flux value, which can be changed by moving the ball to the given vertex and change 

its value in the appropriate spin box in the menu bar. Another easier method for changing flux 

values is available with the ‘+’ and ‘-‘ shortcuts: we hover the mouse near a vertex and when 

using this shortcuts we increase/decrease the flux values for that point. We can also maintain 
one of the keys down and move the mouse around the field, changing the flux where the mouse 

has passed. For easier interpretation, the flux has three different colours depending on its value: 

blue colour for low values, yellow colour for medium values and red colour for high values. 
The Symmetry Option is also available here: any change we make in one side of the field 

will be reflected in the opposite side, reducing, again, the amount of work needed. To see the 

current flux value in a given point, we move the ball to that position and see the result value in 
the appropriate spin box. 

4.2.3 Flux File Format 

After defining the flux it must be saved in a configuration file in order to be modified in 
the future and to the team be able to read it and use it in during the games. The flux is saved in a 
file with the “.conf” suffix. The file format is as it follows: 
 

Begin Flux $nv
$v $ballx $bally $flux
End

 
Since the flux definition depends on a triangulation, it was believed that it made sense to 

be used in conjunction with the formation. So, the formation defines the triangulation and in 
another file we store the flux values. However, the flux shouldn’t be strictly dependent on the 
formation, because the flux continues to make sense even if we use another formation. So, in the 
flux file, besides storing the flux values we also store the triangulation in order to be read by the 
team. This allows us to use any flux definition and any formation, since it is created separated 
triangulations during game. 
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The file format is very simple: at the top we indicate the number of vertices of the 
triangulation, next for each of one those vertices we indicate its vertex number, the ball position 
and the flux value. Theoretically, all the leagues could share the same flux file definition (even 
though in the 3D league the ball can be above the ground, this question was not addressed for 
reasons of simplicity). The only problem is that the ball position is league-dependent, so an 
algorithm would be needed to convert it to the targeted league. Another possible solution was to 
define relative positions instead of absolute positions. 

4.3 Conclusion 

In this chapter it was presented the developed tool in the context of this thesis and the 

algorithms involved for creating advanced formations and for defining game flow. This tool can 
be used in the context of several robotic soccer teams since it was meant from the beginning to 

be generic enough to cope with the requirements of three different leagues of the RoboCup 

competition. 



Matchflow 

 48 



 

49 

5 Results 

The main result of this work was the definition of a generic model of soccer strategy that 

can be applied to several different RoboCup leagues. To support this model a graphical tool was 
developed that allows the definition of advanced formations and game flow. This tool is 

currently being used in at least three RoboCup soccer simulation leagues, sharing a high-level 

process to define advanced formations and game flow, enabling the team to have a flexible 

strategy that can easily exploit other teams‟ weaknesses. 
In this year‟s RoboCup edition the FC Portugal 2D Simulation team finished in the 7

th
 

place. If there wasn‟t an unexpected problem in the penalty-shootout mode, the team could 

easily achieve the 5
th

 or 6
th

 place. However, we believed that the team has been working on a 
new strategy that is pointing the team in the right direction, expecting to take more benefit from 

it in the near future. 

5.1 Formation 

With the aid of the developed graphical tool, several types of formations were defined. We 
adopted the concept of using a different formation for each game situation which led to the 

improvement of the team‟s performance in play-off situations. Here we pretend to test the new 

positioning mechanism which is based on the player who has the ball. 
A series of tests were conducted against different teams using two versions of the FC 

Portugal 2D Simulation team. 

The first version will use our latest formation based on the old mechanism, considering 
only the position of the ball. The second version will use a formation that is based on the 

previous one but introducing the following concepts: 

 

 Defensive formation when the team doesn‟t have the ball in their possession 

 Attacking and supporting formation when the team has the ball having in 

consideration the player who has the ball 
 

Considering this two concepts, the formation will adapt to each situation. Both formations 

are based on a 4-3-3 attacking formation, a common used formation in real soccer. The new 
formation can be found in Appendix B. 

 



Results 

 50 

 
Figure 5.1 - Difference between old and new positioning when not having the possession of the ball 

 

The new formation mechanism depends on the right evaluation of the current situation: if 

we have the ball, and if we do, which player has the ball. In dynamic environments like these, it 

is not trivial to determine with absolute certain the player who has the ball. It will be interesting 
to analyse if the team deals well with the fact that the ball owner changes frequently and to see 

if the team takes advantage of these concepts in the defence and offence. To avoid 

misunderstandings the team with the new positioning system will be called FCP10 and the other 
FCP. 

 

 
Table 5.1 - Matches against bahia2d 

 FCP10 FCP 

Winnings 55 55 

Draws 0 0 

Defeats 0 0 

Goals Scored 793 561 

Goals Conceded 0 0 

 
 

In order to test the new mechanism four different teams were selected ranging from weaker 

teams to a team that has clearly better performance than FC Portugal. The binaries of the teams 
used in the study were from 2009 and a total of 55 matches were made against each team. In 

Table 5.1 we can see that against the weakest team (bahia 2d) only the number of goals scored 

have changed. However, it can be noticed an impressive increase of 41,35% in the goals scored 

in comparison to the old mechanism. 
 

 
Table 5.2 - Matches against ncl09 

 FCP10 FCP 

Winnings 44 36 

Draws 10 16 

Defeats 1 3 

Goals Scored 102 76 

Goals Conceded 11 15 

 
 

Against ncl09 (a medium quality team) the good results continued to appear in all sections 

as depicted in Table 5.2. The team with the new formation mechanism has a lot more victories 
and barely lost any match (only 1 compared to 3 of FCP). Also the FCP10 scored more goals 

(+34,21%) and conceded fewer goals (-26,67%). This is the first example where we can see an 

improvement whether in offence and defence. 
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Table 5.3 - Matches against RoboSampad 

 FCP10 FCP 

Winnings 32 30 

Draws 17 16 

Defeats 6 9 

Goals Scored 62 57 

Goals Conceded 23 28 

 
 

In Table 5.3 we can see that even though the results were better than before in all aspects, 

there is a decrease in the influence of the new mechanism, mainly in the offence. In terms of 
defence, the results are actually quite good with 33,33% of less defeats and -17,85% goals 

conceded. 

 

 
Figure 5.2 - Difference between the old and new positioning when having the possession of the ball (player 7) 

 
The decrease of influence in the attack might be related to the fact that our team not always 

makes the best choices available. Even though we can see an improvement of the positioning of 

the players, not always we take advantage of it, making some choices that compromise our 

success in attack. 
 

 
Table 5.4 - Matches against HelliBash 

 FCP10 FCP 

Winnings 10 9 

Draws 26 21 

Defeats 19 25 

Goals Scored 43 38 

Goals Conceded 51 59 

 
 

The last tests were conducted against a team that we normally lose. We can see very good 

results (Table 5.4) in terms of our defence, decreasing the amount of defeats by 6 (-24%) and 
less 8 goals conceded (-13,56%). Also, a lot more draws than before, indicating that this was a 

good test for our defence, starting to turn the tide in our favour. The attack made also a good 

performance, maintaining the influence from the new mechanism demonstrated in the previous 
test. 

 



Results 

 52 

 
Figure 5.3 - Comparison between match points made in all tests 

 

Overall we can see an improvement of the team‟s performance, whether in offence and 

defence that seem to justify the use of the new positioning mechanism. We believe that this new 

mechanism can be explored even further since it was only used in certain parts of the field. 
Also, the algorithm to determine which player has the ball can be the subject of many 

discussions in order to make wiser decisions. 

5.2 Flux 

Unfortunately the implementation of the new strategy based on the concepts of flux, safety 

and easiness wasn‟t mature enough to be used. However, recent conducted experiments have 

shown promising results: players tending to pass more often to areas high higher flux and 

changing its behaviour by tuning the appropriate parameters. Also, we‟ve changed the 
behaviour of the player‟s dribble to consider the flux definition, having the players dribbling in 

the direction of the flux‟s growth. Overall we can see the team‟s adaptation to different tactics, 

exactly what we‟ve intended to accomplish. We believe that it‟s just a matter of time to this new 
strategy be used. 

5.3 Conclusion 

The new formation mechanism revealed some improvement in the team‟s performance, 

both in defence and offence. Taking in consideration these results and the room for 
improvement, since this concept wasn‟t explored at its full potential, we can conclude that 

Matchflow enables the definition of advanced formations that may easily improve the team‟s 

performance. 
Since the new strategy wasn‟t mature enough to be used, there was no point in conducting 

performance tests. However, in recent experiments, it revealed that the flux is an important 

concept and can change the way the team plays, with very promising results. A high-level 
process was created that enables the team to have a flexible strategy that can easily exploit other 

teams‟ weaknesses. 

 

420 430 440 450 460 470 480

FCP10 match points

FCP match points
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6 Conclusion 

This thesis presented a generic software tool that allowed the definition of advanced 
formations and game flow. This tool is currently being used in at least three RoboCup soccer 

simulation leagues, sharing a high-level process to define the players positioning in the field and 

the flux of a game, enabling the team to have a flexible strategy that can easily exploit other 

teams‟ weaknesses. 
Matchflow was based on an existing tool, which was modified to cope with the necessary 

requirements and specifications of three different leagues. The necessary modules were 

integrated in a common framework that was shared among the leagues, allowing the teams to 
benefit from generic coordination methodologies that have been previously tested in other 

leagues. 

The Triangulation based Positioning Mechanism, a function representation model to 
define a team formation, which utilized Delaunay Triangulation and a linear interpolation 

algorithm was extended in this work. The main idea was similar to SBSP, with the definition of 

player‟s strategic characteristics and formations accordingly to the position of the ball, being 

able to determine the best strategic position for a player in a given moment. We believed that 
depending solely on the ball position wasn‟t enough, and introduced the concepts of defensive 

formation for when not in possession of the ball and an attacking and supporting formation 

when in possession of the ball, the latter depending on which player in the field had the ball. 
These concepts can now be defined in a single formation with the aid of the developed 

graphical tool. This tool has a friendly and intuitive interface and a lot of interesting features 

like the drag-and-drop function that allows moving the ball and the players freely on the field, 

the symmetry option that reduces the amount of work, some visualization hints to understand 
the whole process, among others. The time it requires to define a complete formation, including 

the defensive and attacking positioning, depends on the level of precision we want to achieve. It 

can vary between couple of minutes to a half-hour. 
The performance tests conducted for the evaluation of the new formation mechanism have 

shown promising results. Overall we can see an improvement of the team‟s performance, 

whether in offence and defence that seem to justify the use of the new positioning mechanism. 
The team scored more goals, suffered less and achieved more points in total. We believe that 

this new mechanism can be explored even further since it was only used in certain parts of the 

field. Also, the algorithm to determine which player has the ball can be the subject of many 

discussions in order to make wiser decisions. 
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Regarding the game flow, unfortunately the implementation of the new strategy based on 

the concepts of flux, safety and easiness wasn‟t mature enough to be used. However, recently 
conducted experiments have shown promising results: players tending to pass more often to 

areas high higher flux, players dribbling in the direction of the flux‟s growth, exactly what 

we‟ve intended to accomplish. We believe that it‟s just a matter of time for this new strategy to 
be successfully used in RoboCup international competitions. 

6.1 Future Work 

After the analysis of the conducted tests, we feel very optimistic regarding these changes to 

the actual formation definition methodology. Actually, this concept has not yet being fully 
explored, since it was only used in certain parts of the field. We‟ve concentrated more in tuning 

our offensive and defensive positioning near the opponent‟s area, but expanding its use to the 

whole field can bring even better results. 
Still, there is room for improvement. The positioning mechanism, in our opinion, is one of 

the most important coordination methodologies that a team must deal with. It can help the team 

to achieve better performances just by positioning correctly on the field. Another aspect that we 

believe should be introduced in the formation mechanism is the position of the opponent‟s 
players. If the players don‟t consider the opponent‟s positions they will be in disadvantage from 

the start, since they will be marked by the opponent and be in the worst possible condition to 

receive a ball from a teammate. 
There are at least two possible directions regarding future work: introduce somehow the 

positioning of the opponent‟s players in the formation or go back to the old SBSP positioning 

mechanism and introduce some of the mentioned concepts in this work. The objective here is 
for the players to actively occupy the best position to receive a pass from a teammate, and, when 

not in possession of the ball, to mark the opponent or possible line of passes. The first option 

might be easier and intuitive to define, although the introduction of the opponent‟s players is not 

trivial and how this option would influence the global positioning must be carefully studied. The 
second option is harder to implement but it is more generic and may prove to be more flexible 

than the first one. 
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Appendix A: User Guide 

 

 

 Matchflow - Graphical tool to define 

advanced formations and game flow 

 

USER GUIDE 
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A.1 Introduction 

 

Matchflow is a graphical tool that is able to define advanced formations and game flow. This 

tool was based on a previous existing one named fedit, part of the soccerwindow2 application, 
which allowed the definition of formations based on Delaunay Triangulation and linear 

interpolation algorithm. Several changes has been made to this tool in order to be used in three 

different leagues and to be able to support the changes made on the positioning mechanism, 

which are described in chapter 4, and to define game flow. 
 

Soccerwindow2 Copyright © Hidehisa AKIYAMA 

 
This code is free software; you can redistribute it and/or modify it under the terms of the GNU 

General Public License as published by  the Free Software Foundation; either version 3, or (at 

your option) any later version. 
 

Soccerwindow2 is available at http://rctools.sourceforge.jp/ 

 

Matchflow is also available at http://paginas.fe.up.pt/~ei08017/dissertacao/matchflow.tar.gz 
 

http://rctools.sourceforge.jp/
http://paginas.fe.up.pt/~ei08017/dissertacao/matchflow.tar.gz
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A.2 Matchflow 

A.2.1 Starting the application 

In order to run the application, the user must have an UNIX opperating system and installed the 

following libraries: 

 

 Qt-3.3.x, Qt-4.3 or later  

 boost-1.32 or later 

 

Then, to compile the application the user must run the following commands: 

 
make 

./matchflow 

A.3 Work Environment 

 

Figure A.1 - Work environment for the Matchflow tool 

A.3.1 Title Bar 

 

A.3.2 Menu Bar 
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A.3.3 Tool Bar 

 

A.3.4 Status Bar 

 

A.4 Menu Bar Tools 

 
Figure A.2 - Matchflow file menu bar 

 
Figure A.3 - Matchflow edit mode menu 

 
Figure A.4 - Matchflow Mode menu 

 
Figure A.5 - Matchflow View mode menu 

 
Figure A.6 - Matchflow help mode menu 

A.5 Basic Operations with Matchflow 

New Formation 

File->New Formation 

in alternative press Ctrl + N. 

 

Save Formation 

File->Save Formation 

in alternative press Ctrl + S or click on the  button in the tool bar. 
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Save Formation as 

File->Save formation as... 

 

Open Formation 

File->Open Formation 

in alternative press Ctrl + O. 

 

Open Flux 

File->Open Flux 

in alternative press Ctrl + F. A formation must be opened first, however. 

 

Save Flux 

File->Save flux 

in alternative press Ctrl + S. 

 

Save Flux as 

File->Save flux as... 

 

Quit application 

File->Quit 

in alternative press Ctrl + Q. 
 

Zoom In 

View->Zoom In 

in alternative press Z. 
 

Zoom Out 

View->Zoom Out 
in alternative press X. 

 

Fit Size 

View->Fit Size 

in alternative press I. 

 

Use Symmetry 

Mode->Symmetry 

in alternative press S or click on the  button in the tool bar. 

 

Show Flux 

Mode->Show Flux 

in alternative press F or click on the  button in the tool bar. 

A.6 Advanced Operations with Matchflow 

A.6.1 Create a formation for a specific league 

1. Click on File->New Formation. 



User Guide 

 72 

2. Choose the appropriate league. 

3. Click the Ok button. 

 

 
Figure A.7 - Matchflow league chosen screen 

A.6.2 Define the players’ symmetry 

When creating a new formation it is important to understand the concept of symmetry. When 

players are symmetric and the symmetry option is turned on, a change made to one player will 
affect the other in the same way, in the opposite side of the field, creating a vertical symmetry of 

the team. To define which players are symmetric the following procedure must be taken: 

 

1. Create a new formation or open an existing one. 

2. Click on Mode->Show Edit Dialog or press Ctrl +D. 

3. In the Symmetry column specify the symmetry option. 0 for players without symmetry, 

-1 for players which are symmetric (the first one) putting in the second one the number 

of the first. 

 

 
Figure A.8 - Matchflow player symmetry and edit box 

A.6.3 Define a triangulation 

To be able to define a formation or flux values for different regions on the field, a triangulation 

is required. When it is created an initial formation, there isn't any triangle defined on the field, 

so it can only be define the players positions and the flux value in that point. In order to create 

more points, the following steps must be taken: 
 

1. Click on File->New Formation. 

2. Choose the appropriate league. 

3. Click the Ok button. 
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4. Now to add more points move the ball, by using the drag and drop function, to the 

desired position. 

5. Click on the Edit->Insert option or the Insert button on the toolbar. 

6. A new point will be created in the desired position and another one in the opposite side 

to create the initial triangle. 

7. Repeat the steps from 4 to 6 to add more points to the triangulation. 

 

Note: When the symmetry option is turned on, it will be created two points instead of one. 

A.6.4 Define the players’ positions in the field 

To be able to define the players‟ positions in the field a formation is required. Or a new 

formation is created or a previously defined one can be opened. The procedure for defining the 
players‟ positions follows: 

 
1. Move the ball to the appropriate vertex in the field. 

2. Move the players to the desired positions. 

3. Click on the Replace button. 

 

 
Figure A.9 - Matchflow: defining the players' positions 

 

If you prefer to add a bit more of precision: 
 

1. Move the ball to the appropriate vertex in the field. 

2. Click on Mode->Show Edit Dialog or press Ctrl +D. 

3. Change the players’ positions on the field. 

4. Click in the Apply Button and close the recently opened window. 

5. Click on the Replace button. 
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A.6.5 Delete an existing point in the formation 

To remove a point in the formation is simple: 
 

1. Move the ball to the appropriate vertex in the field. 

2. Click on the Delete button. 

 

Note: When removing a point from the formation, the triangulation will change affecting the 
way how the players positions are interpolated. It is always a good policy to check if any 

significant changes occurred. 

A.6.6 Define the players’ positions when one is in possession of the ball 

The normal mode when defining a formation is considered to be when not in possession of the 

ball. To define the positioning when in possession of the ball, one has to select the player which 
is considered to be in possession and made the necessary adjustments. The complete procedure 

is: 

 

1. Select the player which is considered to be in possession of the ball in the tool bar, by 

using the appropriate spin box. The player will turn red. 

2. Move the ball to the appropriate vertex in the field. 

3. Change the positions of the desired players. 

4. Click on the Replace button. The given vertex number will change its colour to red (if 

it's not already). 

 

 
Figure A.10 - Matchflow defining players' positions when one has the ball 

Note: When changing the mode to the possession of the player, the vertices numbers will 

change to white. This means that these vertices haven't been redefined in this mode. 
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A.6.7 Reverse changes made in player in possession 

To reverse changes made in the player in possession mode, the following steps must be taken: 
 

1. Select the player which is considered to be in possession of the ball in the tool bar, by 

using the appropriate spin box. The player will turn red. 

2. Move the ball to the desired vertex in the field. 

3. Click on the Delete button. The given vertex number will change its colour to white. 

 

Note: The Delete option has different behaviours depending on the formation mode. When the 

player in possession is 0, the Delete option would remove the vertex from the triangulation. 
When the player in possession is different than 0, it would only revert the changes made to that 

vertex, maintaining the triangulation. 

A.6.8 Define flux values for different regions in the field 

To be able to define the flux values for different regions in the field a triangulation is required. 

Or a new formation is created or a previously defined one can be opened. The procedure for 
defining game flow follows: 

 

Click on the Mode->Show Flux option or press F. The triangulation will be hidden, showing 

flux values for each vertex. 

 
1. Move the ball to the desired vertex in the field. If not, the nearest will be automatically 

chosen. 

2. Insert the desired flux value in the appropriate spin box in the tool bar. 

3. Press enter. 

 

 
Figure A.11 - Matchflow flux values for different regions in the field 
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Another easier way to change the flux is to use the mouse and some hotkeys: 
 

1. Click on the Mode->Show Flux option or press F. The triangulation will be hidden, 

showing flux values for each vertex. 

2. Move the mouse to the desired position in the field. 

3. Click '+' to increase the flux in that position (nearest vertex) or '-' to decrease it. The 

mouse can be moved at the same time, speeding up the process. 

 

Note: With the symmetry option turned on, changes in one side of the field will be reflected in 

the opposite side also.
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Appendix B: Formation 

Formation 
DelaunayTriangulation 2D 
Begin Roles 
1 Goalie 0 
2 CenterBack -1 
3 CenterBack -1 
4 SideBack 3 
5 SideBack 2 
6 DefensiveHalf 0 
7 OffensiveHalf -1 
8 OffensiveHalf 7 
9 SideForward 0 
10 SideForward -1 
11 CenterForward 10 
End Roles 
Begin Samples 2 119 
----- 0 ----- 
Ball 54.5 -36 
1 -50 -0 
2 -0.84 8 
3 -0.84 1.08 
4 -0.84 -12 
5 -0.84 -27.3 
6 21.23 -10 
7 29.39 4.47 
8 27.73 -24.39 
9 44.92 -13.42 
10 44.75 0.44 
11 45.27 -25.71 
----- 1 ----- 
Ball 54.5 36 
1 -50 0 
2 -0.84 27.3 
3 -0.84 12 
4 -0.84 -1.08 
5 -0.84 -8 
6 21.23 10 
7 27.73 24.39 
8 29.39 -4.47 
9 44.92 13.42 
10 45.27 25.71 
11 44.75 -0.44 

----- 2 ----- 
Ball 0 0 
1 -50 0 
2 -15.53 15.78 
3 -15.53 5.42 
4 -15.53 -5.42 
5 -15.53 -15.78 
6 -7.46 -0.61 
7 -0.09 13.86 
8 -0.09 -13.86 
9 9.41 -3.12 
10 9.3 23.78 
11 9.3 -23.78 
----- 3 ----- 
Ball 54.5 0 
1 -50 0 
2 2.74 18.58 
3 2.74 6.07 
4 2.74 -6.07 
5 2.74 -18.58 
6 20.71 -0.09 
7 29.04 12.46 
8 29.04 -12.46 
9 45.98 -0.18 
10 45.89 7.98 
11 45.89 -7.98 
----- 4 ----- 
Ball 36.57 -12.09 
1 -50 -0 
2 -1.25 15.67 
3 -1.25 3.2 
4 -1.25 -9.96 
5 -1.25 -23.21 
6 15.09 -4.3 
7 23.08 7.46 
8 24.13 -17.9 
9 41.76 -6.23 
10 41.76 8.48 
11 42.11 -20.62 
----- 5 ----- 
Ball 36.57 12.09 
1 -50 0 

2 -1.25 23.21 
3 -1.25 9.96 
4 -1.25 -3.2 
5 -1.25 -15.67 
6 15.09 4.3 
7 24.13 17.9 
8 23.08 -7.46 
9 41.76 6.23 
10 42.11 20.62 
11 41.76 -8.48 
----- 6 ----- 
Ball 48.51 -15.92 
1 -50 -0 
2 0.51 13.63 
3 0.51 3.38 
4 0.51 -10.77 
5 0.51 -23.46 
6 19.57 -2.54 
7 28.6 10.97 
8 26.76 -14.3 
9 43.78 -8.86 
10 45.1 0.88 
11 45.01 -18.69 
----- 7 ----- 
Ball 48.51 15.92 
1 -50 0 
2 0.51 23.46 
3 0.51 10.77 
4 0.51 -3.38 
5 0.51 -13.63 
6 19.57 2.54 
7 26.76 14.3 
8 28.6 -10.97 
9 43.78 8.86 
10 45.01 18.69 
11 45.1 -0.88 
----- 8 ----- 
Ball 42.76 0 
1 -50 0 
2 0.98 19.24 
3 0.98 5.97 
4 0.98 -5.97 
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5 0.98 -19.24 
6 20.09 -0.44 
7 25.88 12.37 
8 25.88 -12.37 
9 45.54 -0.09 
10 45.89 8.6 
11 45.89 -8.6 
----- 9 ----- 
Ball 48.66 -5.01 
1 -50 0 
2 1.54 17.49 
3 1.54 5.02 
4 1.54 -7.25 
5 1.54 -20.44 
6 22.02 -2.72 
7 30.09 11.93 
8 29.66 -14.65 
9 45.39 -2.58 
10 45.39 5.98 
11 46.36 -13.73 
----- 10 ----- 
Ball 48.66 5.01 
1 -50 -0 
2 1.54 20.44 
3 1.54 7.25 
4 1.54 -5.02 
5 1.54 -17.49 
6 22.02 2.72 
7 29.66 14.65 
8 30.09 -11.93 
9 45.39 2.58 
10 46.36 13.73 
11 45.39 -5.98 
----- 11 ----- 
Ball 50.57 -6.78 
1 -50 -0 
2 1.66 16.82 
3 1.66 4.77 
4 1.66 -7.71 
5 1.66 -20.8 
6 20.97 -2.9 
7 28.95 9.91 
8 29.04 -15.27 
9 45.54 -4.47 
10 45.54 3.42 
11 45.71 -11.84 
----- 12 ----- 
Ball 50.57 6.78 
1 -50 0 
2 1.66 20.8 
3 1.66 7.71 
4 1.66 -4.77 
5 1.66 -16.82 
6 20.97 2.9 
7 29.04 15.27 
8 28.95 -9.91 
9 45.54 4.47 
10 45.71 11.84 

11 45.54 -3.42 
----- 13 ----- 
Ball 52.49 -17.1 
1 -50 -0 
2 0.75 12.86 
3 0.75 3.5 
4 0.75 -10.96 
5 0.75 -23.35 
6 21.76 -4.56 
7 28.34 9.74 
8 27.81 -16.58 
9 44.57 -9.39 
10 45.36 1.05 
11 46.15 -17.99 
----- 14 ----- 
Ball 52.49 17.1 
1 -50 0 
2 0.75 23.35 
3 0.75 10.96 
4 0.75 -3.5 
5 0.75 -12.86 
6 21.76 4.56 
7 27.81 16.58 
8 28.34 -9.74 
9 44.57 9.39 
10 46.15 17.99 
11 45.36 -1.05 
----- 15 ----- 
Ball 52.49 -7.96 
1 -50 -0 
2 1.82 16.31 
3 1.82 4.66 
4 1.82 -7.99 
5 1.82 -20.95 
6 20.88 -1.93 
7 29.3 10.97 
8 29.3 -12.28 
9 45.62 -4.3 
10 45.62 4.12 
11 45.89 -12.81 
----- 16 ----- 
Ball 52.49 7.96 
1 -50 0 
2 1.82 20.95 
3 1.82 7.99 
4 1.82 -4.66 
5 1.82 -16.31 
6 20.88 1.93 
7 29.3 12.28 
8 29.3 -10.97 
9 45.62 4.3 
10 45.89 12.81 
11 45.62 -4.12 
----- 17 ----- 
Ball 49.25 -9.29 
1 -50 0 
2 1.25 16.07 
3 1.25 4.33 

4 1.25 -8.48 
5 1.25 -21.62 
6 22.2 -3.42 
7 28.16 10.18 
8 29.92 -14.92 
9 44.22 -4.47 
10 44.31 4.3 
11 44.31 -12.11 
----- 18 ----- 
Ball 49.25 9.29 
1 -50 -0 
2 1.25 21.62 
3 1.25 8.48 
4 1.25 -4.33 
5 1.25 -16.07 
6 22.2 3.42 
7 29.92 14.92 
8 28.16 -10.18 
9 44.22 4.47 
10 44.31 12.11 
11 44.31 -4.3 
----- 19 ----- 
Ball 46.74 0 
1 -50 0 
2 1.62 19.05 
3 1.62 6.08 
4 1.62 -6.08 
5 1.62 -19.05 
6 21.58 -0.44 
7 27.73 12.2 
8 27.73 -12.2 
9 43.87 -0.18 
10 44.04 7.28 
11 44.04 -7.28 
----- 20 ----- 
Ball 42.61 -5.6 
1 -50 0 
2 0.5 17.56 
3 0.5 4.72 
4 0.5 -7.52 
5 0.5 -20.97 
6 18.43 -2.46 
7 25.62 10.79 
8 26.06 -14.74 
9 43.96 -5.26 
10 43.96 3.25 
11 43.61 -13.95 
----- 21 ----- 
Ball 42.61 5.6 
1 -50 -0 
2 0.5 20.97 
3 0.5 7.52 
4 0.5 -4.72 
5 0.5 -17.56 
6 18.43 2.46 
7 26.06 14.74 
8 25.62 -10.79 
9 43.96 5.26 
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10 43.61 13.95 
11 43.96 -3.25 
----- 22 ----- 
Ball 45.86 -3.54 
1 -50 -0 
2 1.23 18.07 
3 1.23 5.23 
4 1.23 -6.89 
5 1.23 -20.18 
6 21.15 -1.75 
7 28.87 10.62 
8 28.16 -15.88 
9 45.27 -3.33 
10 45.01 4.04 
11 45.27 -11.58 
----- 23 ----- 
Ball 45.86 3.54 
1 -50 0 
2 1.23 20.18 
3 1.23 6.89 
4 1.23 -5.23 
5 1.23 -18.07 
6 21.15 1.75 
7 28.16 15.88 
8 28.87 -10.62 
9 45.27 3.33 
10 45.27 11.58 
11 45.01 -4.04 
----- 24 ----- 
Ball 46.89 -6.49 
1 -50 -0 
2 1.14 17.12 
3 1.14 4.7 
4 1.14 -7.7 
5 1.14 -20.99 
6 21.58 -3.42 
7 28.34 9.83 
8 28.69 -14.39 
9 45.8 -4.83 
10 45.45 2.98 
11 45.89 -15.71 
----- 25 ----- 
Ball 46.89 6.49 
1 -50 0 
2 1.14 20.99 
3 1.14 7.7 
4 1.14 -4.7 
5 1.14 -17.12 
6 21.58 3.42 
7 28.69 14.39 
8 28.34 -9.83 
9 45.8 4.83 
10 45.89 15.71 
11 45.45 -2.98 
----- 26 ----- 
Ball 38.63 0 
1 -50 0 
2 0.18 19.34 

3 0.18 5.93 
4 0.18 -5.93 
5 0.18 -19.34 
6 19.21 -0.53 
7 25.97 12.72 
8 25.97 -12.72 
9 42.82 -0.09 
10 42.9 10 
11 42.9 -10 
----- 27 ----- 
Ball 39.22 -5.75 
1 -50 -0 
2 -0.15 17.6 
3 -0.15 4.57 
4 -0.15 -7.62 
5 -0.15 -21.14 
6 18.07 -3.16 
7 24.3 10 
8 25.97 -14.65 
9 43.43 -5.7 
10 43.52 4.21 
11 42.99 -16.93 
----- 28 ----- 
Ball 39.22 5.75 
1 -50 0 
2 -0.15 21.14 
3 -0.15 7.62 
4 -0.15 -4.57 
5 -0.15 -17.6 
6 18.07 3.16 
7 25.97 14.65 
8 24.3 -10 
9 43.43 5.7 
10 42.99 16.93 
11 43.52 -4.21 
----- 29 ----- 
Ball 30.37 -15.92 
1 -50 0 
2 -3.06 14.49 
3 -3.06 2.05 
4 -3.06 -11.84 
5 -3.06 -24.4 
6 10.88 -6.4 
7 19.3 3.25 
8 15.88 -20.44 
9 34.7 -10.66 
10 34.71 14.57 
11 34.11 -24.3 
----- 30 ----- 
Ball 30.37 15.92 
1 -50 -0 
2 -3.06 24.4 
3 -3.06 11.84 
4 -3.06 -2.05 
5 -3.06 -14.49 
6 10.88 6.4 
7 15.88 20.44 
8 19.3 -3.25 

9 34.7 10.66 
10 34.11 24.3 
11 34.71 -14.57 
----- 31 ----- 
Ball 0 -36 
1 -50 0 
2 -17.18 6.63 
3 -17.18 -6.05 
4 -17.18 -19.96 
5 -17.18 -30.3 
6 -8.38 -16.63 
7 -4.81 -1.58 
8 -5 -27.64 
9 12.9 -16.49 
10 12.81 11.84 
11 13.07 -30.8 
----- 32 ----- 
Ball 0 36 
1 -50 -0 
2 -17.18 30.3 
3 -17.18 19.96 
4 -17.18 6.05 
5 -17.18 -6.63 
6 -8.38 16.63 
7 -5 27.64 
8 -4.81 1.58 
9 12.9 16.49 
10 13.07 30.8 
11 12.81 -11.84 
----- 33 ----- 
Ball 44.53 -22.41 
1 -50 0 
2 -0.79 11.33 
3 -0.79 0.18 
4 -0.79 -13.56 
5 -0.79 -25.3 
6 17.81 -5.26 
7 24.74 10 
8 24.74 -15.97 
9 44.4 -11.14 
10 44.4 0.18 
11 44.75 -20.88 
----- 34 ----- 
Ball 44.53 22.41 
1 -50 -0 
2 -0.79 25.3 
3 -0.79 13.56 
4 -0.79 -0.18 
5 -0.79 -11.33 
6 17.81 5.26 
7 24.74 15.97 
8 24.74 -10 
9 44.4 11.14 
10 44.75 20.88 
11 44.4 -0.18 
----- 35 ----- 
Ball 44.09 -29.78 
1 -50 0 
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2 -1.7 8.96 
3 -1.49 -3.33 
4 -1.7 -16.43 
5 -1.7 -27.12 
6 16.85 -10.27 
7 24.3 4.39 
8 22.02 -24.3 
9 43.08 -12.37 
10 43.08 1.58 
11 43.43 -24.74 
----- 36 ----- 
Ball 38.6 26.17 
1 -50 0 
2 -2.45 26.24 
3 -2.45 15.39 
4 -2.37 2.19 
5 -2.45 -10.33 
6 17.11 11.32 
7 22.9 22.29 
8 24.13 -5.44 
9 42.47 11.41 
10 42.64 23.51 
11 42.55 -4.12 
----- 37 ----- 
Ball 38.6 -26.17 
1 -50 -0 
2 -2.45 10.33 
3 -2.37 -2.19 
4 -2.45 -15.39 
5 -2.45 -26.24 
6 17.11 -11.32 
7 24.13 5.44 
8 22.9 -22.29 
9 42.47 -11.41 
10 42.55 4.12 
11 42.64 -23.51 
----- 38 ----- 
Ball 44.09 29.78 
1 -50 -0 
2 -1.7 27.12 
3 -1.7 16.43 
4 -1.49 3.33 
5 -1.7 -8.96 
6 16.85 10.27 
7 22.02 24.3 
8 24.3 -4.39 
9 43.08 12.37 
10 43.43 24.74 
11 43.08 -1.58 
----- 39 ----- 
Ball 29.19 -34.36 
1 -50 0 
2 -5.36 8.12 
3 -5.18 -5.26 
4 -5.36 -18.8 
5 -5.36 -27.83 
6 15.16 -16.5 
7 22.64 -2.81 

8 19.03 -27.25 
9 34.81 -17.65 
10 34.31 4.91 
11 36.79 -29.36 
----- 40 ----- 
Ball 29.19 34.36 
1 -50 -0 
2 -5.36 27.83 
3 -5.36 18.8 
4 -5.18 5.26 
5 -5.36 -8.12 
6 15.16 16.5 
7 19.03 27.25 
8 22.64 2.81 
9 34.81 17.65 
10 36.79 29.36 
11 34.31 -4.91 
----- 41 ----- 
Ball 33.03 -31.26 
1 -50 0 
2 -4.18 8.83 
3 -4.21 -4.56 
4 -4.18 -17.73 
5 -4.18 -27.43 
6 14.21 -13.25 
7 20.53 1.93 
8 18.16 -25.36 
9 36.32 -11.67 
10 36.67 5.09 
11 35.89 -26.94 
----- 42 ----- 
Ball 33.03 31.26 
1 -50 -0 
2 -4.18 27.43 
3 -4.18 17.73 
4 -4.21 4.56 
5 -4.18 -8.83 
6 14.21 13.25 
7 18.16 25.36 
8 20.53 -1.93 
9 36.32 11.67 
10 35.89 26.94 
11 36.67 -5.09 
----- 43 ----- 
Ball 23 -5.16 
1 -50 0 
2 -4.35 17.45 
3 -4.35 4.1 
4 -4.35 -7.68 
5 -4.35 -20.69 
6 10.52 -4.14 
7 18.29 8.05 
8 15.33 -13.53 
9 29.04 -6 
10 29.83 18.69 
11 29.22 -24.92 
----- 44 ----- 
Ball 23 5.16 

1 -50 -0 
2 -4.35 20.69 
3 -4.35 7.68 
4 -4.35 -4.1 
5 -4.35 -17.45 
6 10.52 4.14 
7 15.33 13.53 
8 18.29 -8.05 
9 29.04 6 
10 29.22 24.92 
11 29.83 -18.69 
----- 45 ----- 
Ball 28.16 0 
1 -50 0 
2 -2.39 19.24 
3 -2.39 5.82 
4 -2.39 -5.82 
5 -2.39 -19.24 
6 14.21 -0.18 
7 19.74 12.28 
8 19.74 -12.28 
9 32.25 -1 
10 32.73 21.06 
11 32.73 -21.06 
----- 46 ----- 
Ball 34.65 -5.75 
1 -50 0 
2 -1.13 17.64 
3 -1.13 4.4 
4 -1.13 -7.7 
5 -1.13 -21.22 
6 14.48 -3.6 
7 21.67 9.56 
8 21.41 -16.23 
9 40.97 -4.47 
10 41.76 11.14 
11 40.8 -19.83 
----- 47 ----- 
Ball 34.65 5.75 
1 -50 -0 
2 -1.13 21.22 
3 -1.13 7.7 
4 -1.13 -4.4 
5 -1.13 -17.64 
6 14.48 3.6 
7 21.41 16.23 
8 21.67 -9.56 
9 40.97 4.47 
10 40.8 19.83 
11 41.76 -11.14 
----- 48 ----- 
Ball 19.91 -28.6 
1 -50 0 
2 -7.44 9.94 
3 -7.37 -3.77 
4 -7.44 -17.45 
5 -7.44 -26.53 
6 3.6 -10.97 
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7 12.2 3.6 
8 10.18 -24.3 
9 28.6 -11.84 
10 28.95 11.58 
11 28.25 -27.99 
----- 49 ----- 
Ball 19.91 28.6 
1 -50 -0 
2 -7.44 26.53 
3 -7.44 17.45 
4 -7.37 3.77 
5 -7.44 -9.94 
6 3.6 10.97 
7 10.18 24.3 
8 12.2 -3.6 
9 28.6 11.84 
10 28.25 27.99 
11 28.95 -11.58 
----- 50 ----- 
Ball 14.3 -11.06 
1 -50 0 
2 -8.06 15.19 
3 -8.06 1.87 
4 -8.06 -10.45 
5 -8.06 -21.99 
6 4.24 -6.29 
7 12.28 5.79 
8 5.05 -17.13 
9 22.95 -9.41 
10 23.25 15.09 
11 21.5 -29.39 
----- 51 ----- 
Ball 14.3 11.06 
1 -50 -0 
2 -8.06 21.99 
3 -8.06 10.45 
4 -8.06 -1.87 
5 -8.06 -15.19 
6 4.24 6.29 
7 5.05 17.13 
8 12.28 -5.79 
9 22.95 9.41 
10 21.5 29.39 
11 23.25 -15.09 
----- 52 ----- 
Ball 11.35 -25.07 
1 -50 0 
2 -10.43 11.03 
3 -10.43 -1.89 
4 -10.43 -16.57 
5 -10.43 -25.58 
6 1.71 -12.12 
7 10 3.42 
8 3.25 -22.2 
9 22.04 -15.92 
10 21.67 13.51 
11 18.9 -29.64 
----- 53 ----- 

Ball 11.35 25.07 
1 -50 -0 
2 -10.43 25.58 
3 -10.43 16.57 
4 -10.43 1.89 
5 -10.43 -11.03 
6 1.71 12.12 
7 3.25 22.2 
8 10 -3.42 
9 22.04 15.92 
10 18.9 29.64 
11 21.67 -13.51 
----- 54 ----- 
Ball 9.58 0 
1 -50 0 
2 -9.77 17.44 
3 -9.77 5.58 
4 -9.77 -5.58 
5 -9.77 -17.44 
6 0.91 -0.62 
7 5.26 12.1 
8 5.26 -12.1 
9 17.81 -1.03 
10 17.64 21.76 
11 17.64 -21.76 
----- 55 ----- 
Ball 18.58 0 
1 -50 0 
2 -5.66 18.6 
3 -5.66 5.71 
4 -5.66 -5.71 
5 -5.66 -18.6 
6 7.55 -0.18 
7 11.95 11.59 
8 11.95 -11.59 
9 25.23 -0.34 
10 24.48 23.08 
11 24.48 -23.08 
----- 56 ----- 
Ball 3.83 -20.2 
1 -50 0 
2 -13.84 11.72 
3 -13.84 -1.74 
4 -13.84 -14.96 
5 -13.84 -24.18 
6 -4.47 -9.91 
7 2.81 4.56 
8 -3.05 -19.66 
9 15.27 -10.62 
10 16.06 14.92 
11 14.04 -27.55 
----- 57 ----- 
Ball 3.83 20.2 
1 -50 -0 
2 -13.84 24.18 
3 -13.84 14.96 
4 -13.84 1.74 
5 -13.84 -11.72 

6 -4.47 9.91 
7 -3.05 19.66 
8 2.81 -4.56 
9 15.27 10.62 
10 14.04 27.55 
11 16.06 -14.92 
----- 58 ----- 
Ball 6.19 -10.32 
1 -50 0 
2 -11.99 14.2 
3 -11.99 1.49 
4 -11.99 -10.37 
5 -11.99 -20.75 
6 -2.15 -5.86 
7 7.63 8.34 
8 -0.16 -16.34 
9 16.23 -9.25 
10 17.28 17.81 
11 11.66 -29.11 
----- 59 ----- 
Ball 6.19 10.32 
1 -50 -0 
2 -11.99 20.75 
3 -11.99 10.37 
4 -11.99 -1.49 
5 -11.99 -14.2 
6 -2.15 5.86 
7 -0.16 16.34 
8 7.63 -8.34 
9 16.23 9.25 
10 11.66 29.11 
11 17.28 -17.81 
----- 60 ----- 
Ball 10.47 -29.78 
1 -50 0 
2 -11.25 9.34 
3 -11.25 -3 
4 -11.25 -18.18 
5 -11.25 -26.52 
6 0.92 -14.14 
7 8.34 1.84 
8 3.65 -23.76 
9 21.84 -17.79 
10 22.11 10.27 
11 19.43 -31.04 
----- 61 ----- 
Ball 10.47 29.78 
1 -50 -0 
2 -11.25 26.52 
3 -11.25 18.18 
4 -11.25 3 
5 -11.25 -9.34 
6 0.92 14.14 
7 3.65 23.76 
8 8.34 -1.84 
9 21.84 17.79 
10 19.43 31.04 
11 22.11 -10.27 
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----- 62 ----- 
Ball 13.27 -33.18 
1 -50 0 
2 -10.35 7.81 
3 -10.35 -6.23 
4 -10.53 -17.99 
5 -10.4 -27.14 
6 2.19 -12.81 
7 10.09 1.67 
8 7.31 -25.26 
9 24.21 -18.79 
10 24.22 9.74 
11 22.52 -31.88 
----- 63 ----- 
Ball 13.27 33.18 
1 -50 -0 
2 -10.4 27.14 
3 -10.53 17.99 
4 -10.35 6.23 
5 -10.35 -7.81 
6 2.19 12.81 
7 7.31 25.26 
8 10.09 -1.67 
9 24.21 18.79 
10 22.52 31.88 
11 24.22 -9.74 
----- 64 ----- 
Ball -16.96 -30.52 
1 -50 0 
2 -23.94 9.35 
3 -23.94 -4.34 
4 -23.94 -18.45 
5 -23.94 -27.93 
6 -19.24 -13.98 
7 -14.1 -0.07 
8 -16.23 -25.53 
9 0.06 -9.81 
10 -4.28 17.04 
11 0.44 -30.41 
----- 65 ----- 
Ball -16.96 30.52 
1 -50 -0 
2 -23.94 27.93 
3 -23.94 18.45 
4 -23.94 4.34 
5 -23.94 -9.35 
6 -19.24 13.98 
7 -16.23 25.53 
8 -14.1 0.07 
9 0.06 9.81 
10 0.44 30.41 
11 -4.28 -17.04 
----- 66 ----- 
Ball -4.28 -16.81 
1 -50 0 
2 -14.88 11.13 
3 -14.88 -3.68 
4 -14.88 -15.79 

5 -14.88 -23.07 
6 -8.8 -11.13 
7 -3.98 5.9 
8 -3.79 -19.5 
9 5.59 -8.48 
10 2.6 22.3 
11 6.03 -29.81 
----- 67 ----- 
Ball -4.28 16.81 
1 -50 -0 
2 -14.88 23.07 
3 -14.88 15.79 
4 -14.88 3.68 
5 -14.88 -11.13 
6 -8.8 11.13 
7 -3.79 19.5 
8 -3.98 -5.9 
9 5.59 8.48 
10 6.03 29.81 
11 2.6 -22.3 
----- 68 ----- 
Ball -7.08 -27.57 
1 -50 -0 
2 -16.57 10.45 
3 -16.57 -4.96 
4 -16.57 -19.34 
5 -16.57 -27.21 
6 -10.91 -14.26 
7 -6.22 1.56 
8 -6.93 -25.01 
9 6.91 -10.52 
10 1.32 18.51 
11 6.84 -30.97 
----- 69 ----- 
Ball -7.08 27.57 
1 -50 0 
2 -16.57 27.21 
3 -16.57 19.34 
4 -16.57 4.96 
5 -16.57 -10.45 
6 -10.91 14.26 
7 -6.93 25.01 
8 -6.22 -1.56 
9 6.91 10.52 
10 6.84 30.97 
11 1.32 -18.51 
----- 70 ----- 
Ball -0.65 -30.85 
1 -50 -0 
2 -16.34 8.52 
3 -16.34 -4.9 
4 -16.34 -18.76 
5 -16.34 -28.34 
6 -8.07 -14.69 
7 -1.9 -0.16 
8 -5.44 -26.32 
9 13.42 -15.79 
10 12.99 13.07 

11 11.62 -30.89 
----- 71 ----- 
Ball -0.65 30.85 
1 -50 0 
2 -16.34 28.34 
3 -16.34 18.76 
4 -16.34 4.9 
5 -16.34 -8.52 
6 -8.07 14.69 
7 -5.44 26.32 
8 -1.9 0.16 
9 13.42 15.79 
10 11.62 30.89 
11 12.99 -13.07 
----- 72 ----- 
Ball -23.89 -34.21 
1 -50 0 
2 -31.05 8.6 
3 -31.05 -4.33 
4 -31.05 -17.31 
5 -31.05 -27.83 
6 -24.69 -13.7 
7 -19.22 -1.39 
8 -22.94 -23.29 
9 -3.41 -8.93 
10 -7.83 15.33 
11 -3.39 -30.07 
----- 73 ----- 
Ball -23.89 34.21 
1 -50 -0 
2 -31.05 27.83 
3 -31.05 17.31 
4 -31.05 4.33 
5 -31.05 -8.6 
6 -24.69 13.7 
7 -22.94 23.29 
8 -19.22 1.39 
9 -3.41 8.93 
10 -3.39 30.07 
11 -7.83 -15.33 
----- 74 ----- 
Ball -54.5 0 
1 -50 0 
2 -49.99 6.88 
3 -49.99 3.17 
4 -49.99 -3.17 
5 -49.99 -6.88 
6 -44.06 1.02 
7 -41.64 8.61 
8 -41.64 -8.61 
9 -30.03 4.57 
10 -23.83 22.2 
11 -23.83 -22.2 
----- 75 ----- 
Ball -19.61 -5.46 
1 -50 0 
2 -25 9.88 
3 -25 1.07 
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4 -25 -7.22 
5 -25 -15.59 
6 -21.07 -4.5 
7 -17.58 8.75 
8 -18.04 -13.11 
9 -8.99 -3.01 
10 -6.72 24.53 
11 -6.06 -26.78 
----- 76 ----- 
Ball -19.61 5.46 
1 -50 -0 
2 -25 15.59 
3 -25 7.22 
4 -25 -1.07 
5 -25 -9.88 
6 -21.07 4.5 
7 -18.04 13.11 
8 -17.58 -8.75 
9 -8.99 3.01 
10 -6.06 26.78 
11 -6.72 -24.53 
----- 77 ----- 
Ball -7.96 -7.37 
1 -50 0 
2 -17.18 12.59 
3 -17.18 0.07 
4 -17.18 -9.85 
5 -17.18 -19.09 
6 -12.21 -6.37 
7 -7.25 9.27 
8 -7.34 -15.32 
9 0.76 -4.5 
10 0.38 24.81 
11 1.69 -28.01 
----- 78 ----- 
Ball -7.96 7.37 
1 -50 -0 
2 -17.18 19.09 
3 -17.18 9.85 
4 -17.18 -0.07 
5 -17.18 -12.59 
6 -12.21 6.37 
7 -7.34 15.32 
8 -7.25 -9.27 
9 0.76 4.5 
10 1.69 28.01 
11 0.38 -24.81 
----- 79 ----- 
Ball -5.31 0 
1 -50 0 
2 -14.82 16.26 
3 -14.82 4.5 
4 -14.82 -4.5 
5 -14.82 -16.26 
6 -9.26 -1.26 
7 -4.86 12.66 
8 -4.86 -12.66 
9 2.2 -0.09 

10 2.61 26.72 
11 2.61 -26.72 
----- 80 ----- 
Ball -2.06 -11.35 
1 -50 0 
2 -13.56 13.02 
3 -13.56 -2.16 
4 -13.56 -12.91 
5 -13.56 -21.01 
6 -6.73 -8.68 
7 -2.03 8.39 
8 -1.72 -17.72 
9 6.06 -6.47 
10 4.06 24.04 
11 6.48 -29.12 
----- 81 ----- 
Ball -2.06 11.35 
1 -50 -0 
2 -13.56 21.01 
3 -13.56 12.91 
4 -13.56 2.16 
5 -13.56 -13.02 
6 -6.73 8.68 
7 -1.72 17.72 
8 -2.03 -8.39 
9 6.06 6.47 
10 6.48 29.12 
11 4.06 -24.04 
----- 82 ----- 
Ball -3.39 -5.9 
1 -50 0 
2 -14.14 14.39 
3 -14.14 0.58 
4 -14.14 -8.99 
5 -14.14 -18.92 
6 -7.76 -5.48 
7 -3.16 10.48 
8 -3.04 -15.36 
9 4.7 -3.75 
10 3.43 25.44 
11 4.62 -28.05 
----- 83 ----- 
Ball -3.39 5.9 
1 -50 -0 
2 -14.14 18.92 
3 -14.14 8.99 
4 -14.14 -0.58 
5 -14.14 -14.39 
6 -7.76 5.48 
7 -3.04 15.36 
8 -3.16 -10.48 
9 4.7 3.75 
10 4.62 28.05 
11 3.43 -25.44 
----- 84 ----- 
Ball -9.44 -24.77 
1 -50 0 
2 -17.92 9.67 

3 -17.92 -4.5 
4 -17.92 -18.28 
5 -17.92 -26.25 
6 -13.12 -13.42 
7 -8.23 2.36 
8 -8.86 -21.71 
9 3.59 -10.02 
10 -0.29 19.43 
11 4.27 -30.45 
----- 85 ----- 
Ball -9.44 24.77 
1 -50 -0 
2 -17.92 26.25 
3 -17.92 18.28 
4 -17.92 4.5 
5 -17.92 -9.67 
6 -13.12 13.42 
7 -8.86 21.71 
8 -8.23 -2.36 
9 3.59 10.02 
10 4.27 30.45 
11 -0.29 -19.43 
----- 86 ----- 
Ball -12.39 -12.39 
1 -50 0 
2 -20.71 9.72 
3 -20.71 -1.72 
4 -20.71 -12.64 
5 -20.71 -20.92 
6 -16.37 -8.83 
7 -11.06 6.74 
8 -11.58 -16.74 
9 -2.1 -6.61 
10 -2.47 23.22 
11 -0.53 -28.52 
----- 87 ----- 
Ball -12.39 12.39 
1 -50 -0 
2 -20.71 20.92 
3 -20.71 12.64 
4 -20.71 1.72 
5 -20.71 -9.72 
6 -16.37 8.83 
7 -11.58 16.74 
8 -11.06 -6.74 
9 -2.1 6.61 
10 -0.53 28.52 
11 -2.47 -23.22 
----- 88 ----- 
Ball -16.37 -15.78 
1 -50 0 
2 -24.22 8.03 
3 -24.22 -2.52 
4 -24.22 -13.78 
5 -24.22 -21.95 
6 -19.87 -9.96 
7 -14.35 5.07 
8 -15.41 -17.57 
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9 -4.48 -7.55 
10 -4.82 22.01 
11 -2.6 -28.7 
----- 89 ----- 
Ball -16.37 15.78 
1 -50 -0 
2 -24.22 21.95 
3 -24.22 13.78 
4 -24.22 2.52 
5 -24.22 -8.03 
6 -19.87 9.96 
7 -15.41 17.57 
8 -14.35 -5.07 
9 -4.48 7.55 
10 -2.6 28.7 
11 -4.82 -22.01 
----- 90 ----- 
Ball -19.91 -18.28 
1 -50 0 
2 -27.37 6.95 
3 -27.37 -3.02 
4 -27.37 -14.13 
5 -27.37 -22.39 
6 -22.83 -10.5 
7 -17.16 3.88 
8 -18.77 -18.12 
9 -6.47 -7.96 
10 -6.79 21.05 
11 -4.47 -28.73 
----- 91 ----- 
Ball -19.91 18.28 
1 -50 -0 
2 -27.37 22.39 
3 -27.37 14.13 
4 -27.37 3.02 
5 -27.37 -6.95 
6 -22.83 10.5 
7 -18.77 18.12 
8 -17.16 -3.88 
9 -6.47 7.96 
10 -4.47 28.73 
11 -6.79 -21.05 
----- 92 ----- 
Ball -32.73 -29.19 
1 -50 -0 
2 -37 4.45 
3 -37 -4.58 
4 -37 -13.44 
5 -37 -22.97 
6 -32.34 -11.42 
7 -26.1 -0.09 
8 -30.52 -20.74 
9 -12 -7.92 
10 -13.04 16.63 
11 -10.38 -28.63 
----- 93 ----- 
Ball -32.73 29.19 
1 -50 0 

2 -37 22.97 
3 -37 13.44 
4 -37 4.58 
5 -37 -4.45 
6 -32.34 11.42 
7 -30.52 20.74 
8 -26.1 0.09 
9 -12 7.92 
10 -10.38 28.63 
11 -13.04 -16.63 
----- 94 ----- 
Ball -24.03 -17.55 
1 -50 0 
2 -28 5.87 
3 -28 -2.95 
4 -28 -12.75 
5 -28 -20 
6 -24.93 -9.38 
7 -20.54 3.87 
8 -22.45 -17.38 
9 -9.46 -7.39 
10 -9.15 21.01 
11 -7.22 -28.24 
----- 95 ----- 
Ball -24.03 17.55 
1 -50 -0 
2 -28 20 
3 -28 12.75 
4 -28 2.95 
5 -28 -5.87 
6 -24.93 9.38 
7 -22.45 17.38 
8 -20.54 -3.87 
9 -9.46 7.39 
10 -7.22 28.24 
11 -9.15 -21.01 
----- 96 ----- 
Ball -31.26 0 
1 -50 0 
2 -37 8.03 
3 -37 2.16 
4 -37 -2.16 
5 -37 -8.03 
6 -32.56 -0.43 
7 -27.38 9.85 
8 -27.38 -9.85 
9 -18.33 1.17 
10 -13.07 24.74 
11 -13.07 -24.74 
----- 97 ----- 
Ball -29.34 -15.33 
1 -50 -0 
2 -34 4.57 
3 -34 -2.72 
4 -34 -10.26 
5 -34 -17.42 
6 -29.56 -8.1 
7 -24.81 4.35 

8 -26.82 -15.97 
9 -13.3 -6.21 
10 -12.11 21.27 
11 -10.73 -27.4 
----- 98 ----- 
Ball -29.34 15.33 
1 -50 0 
2 -34 17.42 
3 -34 10.26 
4 -34 2.72 
5 -34 -4.57 
6 -29.56 8.1 
7 -26.82 15.97 
8 -24.81 -4.35 
9 -13.3 6.21 
10 -10.73 27.4 
11 -12.11 -21.27 
----- 99 ----- 
Ball -37.01 -33.03 
1 -50 0 
2 -40.77 3.64 
3 -40.57 -4.62 
4 -40.77 -12.81 
5 -40.77 -23.04 
6 -34.61 -11.31 
7 -28.64 -1.11 
8 -33.87 -21.66 
9 -13.43 -7.26 
10 -14.85 14.96 
11 -12.13 -28.47 
----- 100 ----- 
Ball -37.01 33.03 
1 -50 -0 
2 -40.77 23.04 
3 -40.77 12.81 
4 -40.57 4.62 
5 -40.77 -3.64 
6 -34.61 11.31 
7 -33.87 21.66 
8 -28.64 1.11 
9 -13.43 7.26 
10 -12.13 28.47 
11 -14.85 -14.96 
----- 101 ----- 
Ball -54.5 -36 
1 -50 0 
2 -46.68 4.2 
3 -45.71 -4.04 
4 -47.45 -10.29 
5 -48.45 -21.85 
6 -42.6 -8.28 
7 -38.36 -1.28 
8 -42.89 -21.18 
9 -22.8 -4.37 
10 -22.49 12.44 
11 -20.87 -26.29 
----- 102 ----- 
Ball -54.5 36 
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1 -50 -0 
2 -48.45 21.85 
3 -47.45 10.29 
4 -45.71 4.04 
5 -46.68 -4.2 
6 -42.6 8.28 
7 -42.89 21.18 
8 -38.36 1.28 
9 -22.8 4.37 
10 -20.87 26.29 
11 -22.49 -12.44 
----- 103 ----- 
Ball -48.66 -22.71 
1 -50 -0 
2 -46.26 2.84 
3 -45.14 -2.25 
4 -46.44 -8.98 
5 -46.7 -15.63 
6 -41.76 -7.28 
7 -37.8 1.5 
8 -41 -14.79 
9 -22.29 -5.05 
10 -21.01 17.44 
11 -19.94 -26.01 
----- 104 ----- 
Ball -48.66 22.71 
1 -50 0 
2 -46.7 15.63 
3 -46.44 8.98 
4 -45.14 2.25 
5 -46.26 -2.84 
6 -41.76 7.28 
7 -41 14.79 
8 -37.8 -1.5 
9 -22.29 5.05 
10 -19.94 26.01 
11 -21.01 -17.44 
----- 105 ----- 
Ball -39.52 -28.16 
1 -50 0 
2 -41.2 2.74 
3 -41.2 -4.34 
4 -41.2 -11.32 
5 -40.9 -20.13 
6 -37.51 -10.01 
7 -30.74 0.19 
8 -36.24 -18.25 
9 -16.44 -6.95 
10 -16.49 16.49 
11 -14.51 -27.72 
----- 106 ----- 
Ball -39.52 28.16 
1 -50 -0 
2 -40.9 20.13 
3 -41.2 11.32 
4 -41.2 4.34 
5 -41.2 -2.74 
6 -37.51 10.01 

7 -36.24 18.25 
8 -30.74 -0.19 
9 -16.44 6.95 
10 -14.51 27.72 
11 -16.49 -16.49 
----- 107 ----- 
Ball -39.22 -22.12 
1 -50 -0 
2 -41.4 2.69 
3 -41 -3.81 
4 -41.4 -10.02 
5 -40.86 -17.18 
6 -36.9 -8.77 
7 -31.14 1.89 
8 -34.95 -16.83 
9 -17.55 -6.43 
10 -16.77 18.47 
11 -15.29 -27.15 
----- 108 ----- 
Ball -39.22 22.12 
1 -50 0 
2 -40.86 17.18 
3 -41.4 10.02 
4 -41 3.81 
5 -41.4 -2.69 
6 -36.9 8.77 
7 -34.95 16.83 
8 -31.14 -1.89 
9 -17.55 6.43 
10 -15.29 27.15 
11 -16.77 -18.47 
----- 109 ----- 
Ball -41.58 -7.22 
1 -50 -0 
2 -43.59 3.99 
3 -41.76 -0.13 
4 -43.59 -4.05 
5 -43.59 -8.55 
6 -38.84 -3.44 
7 -33.99 6.61 
8 -37.78 -9.51 
9 -21.98 -1.47 
10 -18.33 22.22 
11 -17.94 -24.94 
----- 110 ----- 
Ball -47.32 16.47 
1 -50 0 
2 -46.56 12.74 
3 -46.53 7.18 
4 -44.87 1.41 
5 -46.45 -3.45 
6 -41.44 5.76 
7 -40.99 11.82 
8 -38.55 -2.96 
9 -22.78 3.54 
10 -19.82 25.44 
11 -20.63 -19.24 
----- 111 ----- 

Ball -47.32 -16.47 
1 -50 -0 
2 -46.45 3.45 
3 -44.87 -1.41 
4 -46.53 -7.18 
5 -46.56 -12.74 
6 -41.44 -5.76 
7 -38.55 2.96 
8 -40.99 -11.82 
9 -22.78 -3.54 
10 -20.63 19.24 
11 -19.82 -25.44 
----- 112 ----- 
Ball -41.58 7.22 
1 -50 0 
2 -43.59 8.55 
3 -43.59 4.05 
4 -41.76 0.13 
5 -43.59 -3.99 
6 -38.84 3.44 
7 -37.78 9.51 
8 -33.99 -6.61 
9 -21.98 1.47 
10 -17.94 24.94 
11 -18.33 -22.22 
----- 113 ----- 
Ball -34.06 -7.37 
1 -50 0 
2 -39.1 4.73 
3 -39.1 -0.8 
4 -39.1 -5.15 
5 -39.1 -10.73 
6 -34.82 -6.17 
7 -32.25 6.92 
8 -29.99 -12.46 
9 -17.91 -2.58 
10 -14.67 22.91 
11 -14.14 -25.77 
----- 114 ----- 
Ball -34.06 7.37 
1 -50 -0 
2 -39.1 10.73 
3 -39.1 5.15 
4 -39.1 0.8 
5 -39.1 -4.73 
6 -34.82 6.17 
7 -29.99 12.46 
8 -32.25 -6.92 
9 -17.91 2.58 
10 -14.14 25.77 
11 -14.67 -22.91 
----- 115 ----- 
Ball -48.22 -9.88 
1 -50 -0 
2 -47.87 4.14 
3 -45.36 -0.51 
4 -47.87 -4.98 
5 -47.87 -9.24 
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6 -41.91 -3.75 
7 -37.64 5.54 
8 -41.63 -9.38 
9 -24.49 -1.57 
10 -21.27 20.92 
11 -20.84 -24.54 
----- 116 ----- 
Ball -48.22 9.88 
1 -50 0 
2 -47.87 9.24 
3 -47.87 4.98 
4 -45.36 0.51 
5 -47.87 -4.14 
6 -41.91 3.75 
7 -41.63 9.38 
8 -37.64 -5.54 
9 -24.49 1.57 
10 -20.84 24.54 
11 -21.27 -20.92 
----- 117 ----- 
Ball 15.33 -21.38 
1 -50 0 
2 -8.43 12.47 
3 -8.43 -0.58 
4 -8.43 -14.97 
5 -8.43 -25.05 
6 4.93 -10.62 
7 10.62 4.83 
8 4.93 -21.15 
9 24.72 -14.15 
10 23.87 12.2 
11 21.33 -29.66 
----- 118 ----- 
Ball 15.33 21.38 
1 -50 -0 
2 -8.43 25.05 
3 -8.43 14.97 
4 -8.43 0.58 
5 -8.43 -12.47 
6 4.93 10.62 
7 4.93 21.15 
8 10.62 -4.83 
9 24.72 14.15 
10 21.33 29.66 
11 23.87 -12.2 
End Samples 
Begin Player With Ball 
Samples 5 
Player 7 29 
6 4 
7 48.57 -15.93 
9 47.73 -6.49 
10 42.29 -0.09 
11 44.33 -22.87 
29 5 
7 30.33 -16.06 
8 16.58 -21.67 
9 44.98 -7.58 

10 43.61 1.93 
11 42.11 -24.3 
45 5 
6 14.21 0.18 
7 28.14 -0.13 
9 42.9 -7.46 
10 42.82 5.44 
11 41.33 -20 
8 5 
6 21.77 2.76 
7 42.79 -0 
9 46.65 -4.24 
10 46.13 3.98 
11 43.82 -12.85 
20 4 
7 42.66 -5.65 
9 47.93 -5.91 
10 44.2 0.39 
11 45.1 -14.14 
26 4 
6 19.71 2.62 
7 38.68 -0.13 
9 45.49 -3.86 
10 45.62 4.75 
27 4 
7 39.19 -5.78 
9 45.62 -9.74 
10 44.31 0.61 
11 43.05 -15.81 
46 4 
7 34.7 -5.78 
9 44.92 -12.63 
10 44.66 1.49 
11 43.08 -24.04 
4 4 
7 36.62 -12.34 
9 44.75 -11.93 
10 44.57 -0.44 
11 44.31 -24.13 
21 4 
7 42.53 5.78 
8 31.32 -9.12 
9 47.38 5.7 
11 45.01 -3.6 
28 3 
7 39.45 5.91 
9 46.59 5.7 
11 44.48 -2.54 
47 6 
6 16.76 5 
7 34.7 5.78 
8 29.39 -12.55 
9 46.24 5.79 
10 45.98 13.86 
11 43.96 -2.46 
14 5 
7 52.43 16.96 
8 37.03 3.51 

9 49.09 7.71 
10 40.54 14.65 
11 42.99 -1.4 
7 5 
7 48.57 15.81 
8 38.16 4.63 
9 48.32 7.58 
10 40.86 11.57 
11 44.13 -0.09 
5 5 
7 36.62 11.95 
8 30.8 -5.7 
9 45.8 7.28 
10 43.82 21.2 
11 44.4 -1.4 
30 5 
7 30.33 15.93 
8 27.55 -5.97 
9 45.19 7.63 
10 41.63 28.78 
11 42.47 -0.97 
34 6 
6 16.49 10 
7 44.59 22.36 
8 33.52 0.26 
9 45.62 10.27 
10 37.29 15.09 
11 43.26 -0.09 
1 6 
6 19.65 16.67 
7 54.5 35.98 
8 34.57 7.37 
9 47.55 15.09 
10 42.55 29.3 
11 44.85 1.29 
38 6 
6 17.28 15.53 
7 44.08 29.68 
8 33.34 4.74 
9 46.15 12.81 
10 37.11 18.86 
11 43.82 1.67 
36 6 
6 18.69 16.14 
7 38.55 26.21 
8 30.45 4.39 
9 46.13 10.92 
10 44.2 29.68 
11 42.99 0 
40 5 
6 12.81 18.43 
7 29.3 34.18 
8 22.72 3.16 
10 40.48 31.87 
11 34.82 -9.25 
42 6 
6 15.71 16.23 
7 32.9 31.23 
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8 25.36 3.95 
9 39.58 16.32 
10 43.56 29.68 
11 38.94 -5.53 
51 2 
7 14.26 11.05 
10 22.46 29.48 
118 4 
6 4.47 12.55 
7 15.29 21.33 
8 13.51 -2.37 
10 25.19 30.2 
49 4 
6 7.02 14.65 
7 20.05 28.53 
8 15.62 -1.67 
10 31.35 31.35 
63 3 
6 2.37 16.06 
7 13.36 33.02 
10 24.67 32.64 
61 3 
6 2.19 15.62 
7 10.41 29.68 
10 22.74 32.51 
53 2 
7 11.31 25.06 
10 22.36 29.81 
57 2 
7 3.73 20.17 
10 15.81 28.4 
Player 8 29 
7 4 
8 48.57 15.93 
9 47.73 6.49 
10 44.33 22.87 
11 42.29 0.09 
30 5 
7 16.58 21.67 
8 30.33 16.06 
9 44.98 7.58 
10 42.11 24.3 
11 43.61 -1.93 
45 4 
8 28.14 0.13 
9 42.9 7.46 
10 41.33 20 
11 42.82 -5.44 
8 4 
8 42.79 0 
9 46.65 4.24 
10 43.82 12.85 
11 46.13 -3.98 
21 4 
8 42.66 5.65 
9 47.93 5.91 
10 45.1 14.14 
11 44.2 -0.39 

26 3 
8 38.68 0.13 
9 45.49 3.86 
11 45.62 -4.75 
28 4 
8 39.19 5.78 
9 45.62 9.74 
10 43.05 15.81 
11 44.31 -0.61 
47 4 
8 34.7 5.78 
9 44.92 12.63 
10 43.08 24.04 
11 44.66 -1.49 
5 4 
8 36.62 12.34 
9 44.75 11.93 
10 44.31 24.13 
11 44.57 0.44 
20 4 
7 31.32 9.12 
8 42.53 -5.78 
9 47.38 -5.7 
10 45.01 3.6 
27 3 
8 39.45 -5.91 
9 46.59 -5.7 
10 44.48 2.54 
46 6 
6 16.76 -5 
7 29.39 12.55 
8 34.7 -5.78 
9 46.24 -5.79 
10 43.96 2.46 
11 45.98 -13.86 
13 5 
7 37.03 -3.51 
8 52.43 -16.96 
9 49.09 -7.71 
10 42.99 1.4 
11 40.54 -14.65 
6 5 
7 38.16 -4.63 
8 48.57 -15.81 
9 48.32 -7.58 
10 44.13 0.09 
11 40.86 -11.57 
4 5 
7 30.8 5.7 
8 36.62 -11.95 
9 45.8 -7.28 
10 44.4 1.4 
11 43.82 -21.2 
29 5 
7 27.55 5.97 
8 30.33 -15.93 
9 45.19 -7.63 
10 42.47 0.97 

11 41.63 -28.78 
33 6 
6 16.49 -10 
7 33.52 -0.26 
8 44.59 -22.36 
9 45.62 -10.27 
10 43.26 0.09 
11 37.29 -15.09 
0 6 
6 19.65 -16.67 
7 34.57 -7.37 
8 54.5 -35.98 
9 47.55 -15.09 
10 44.85 -1.29 
11 42.55 -29.3 
35 6 
6 17.28 -15.53 
7 33.34 -4.74 
8 44.08 -29.68 
9 46.15 -12.81 
10 43.82 -1.67 
11 37.11 -18.86 
37 6 
6 18.69 -16.14 
7 30.45 -4.39 
8 38.55 -26.21 
9 46.13 -10.92 
10 42.99 -0 
11 44.2 -29.68 
39 5 
6 12.81 -18.43 
7 22.72 -3.16 
8 29.3 -34.18 
10 34.82 9.25 
11 40.48 -31.87 
41 6 
6 15.71 -16.23 
7 25.36 -3.95 
8 32.9 -31.23 
9 39.58 -16.32 
10 38.94 5.53 
11 43.56 -29.68 
50 2 
8 14.26 -11.05 
11 22.46 -29.48 
117 4 
6 4.47 -12.55 
7 13.51 2.37 
8 15.29 -21.33 
11 25.19 -30.2 
48 4 
6 7.02 -14.65 
7 15.62 1.67 
8 20.05 -28.53 
11 31.35 -31.35 
62 3 
6 2.37 -16.06 
8 13.36 -33.02 
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11 24.67 -32.64 
60 3 
6 2.19 -15.62 
8 10.41 -29.68 
11 22.74 -32.51 
52 2 
8 11.31 -25.06 
11 22.36 -29.81 
56 2 
8 3.73 -20.17 
11 15.81 -28.4 
Player 9 27 
15 2 
9 52.3 -7.97 
10 46.13 1.16 
16 2 
9 52.3 7.97 
11 46.13 -1.16 
29 5 
7 25.09 4.65 
8 18.34 -20.88 
9 30.33 -16.06 
10 40.45 5.79 
11 36.37 -25.19 
30 5 
7 18.34 20.88 
8 25.09 -4.65 
9 30.33 16.06 
10 36.37 25.19 
11 40.45 -5.79 
37 4 
7 33.28 -8.61 
9 38.55 -26.34 
10 42.79 -3.98 
11 42.41 -32.77 
36 4 
8 33.28 8.61 
9 38.55 26.34 
10 42.41 32.77 
11 42.79 3.98 
33 5 
7 34.57 1.32 
8 30.27 -16.23 
9 44.46 -22.49 
10 45.1 -3.95 
11 43.95 -30.33 
34 5 
7 30.27 16.23 
8 34.57 -1.32 
9 44.46 22.49 
10 43.95 30.33 
11 45.1 3.95 
4 5 
7 31.41 4.74 
8 25.18 -17.81 
9 36.62 -12.08 
10 42.28 -0.13 
11 41.38 -21.2 

5 5 
7 25.18 17.81 
8 31.41 -4.74 
9 36.62 12.08 
10 41.38 21.2 
11 42.28 0.13 
46 5 
7 29.22 11.06 
8 26.5 -17.11 
9 34.7 -5.65 
10 44.48 3.07 
11 39.45 -19.02 
47 5 
7 26.5 17.11 
8 29.22 -11.06 
9 34.7 5.65 
10 39.45 19.02 
11 44.48 -3.07 
43 3 
9 23 -5.14 
10 29.43 18.38 
11 26.99 -23.52 
44 3 
9 23 5.14 
10 26.99 23.52 
11 29.43 -18.38 
13 5 
7 33.87 2.9 
8 34.04 -12.9 
9 52.3 -17.09 
10 45.45 -4.12 
11 45.1 -23.77 
14 5 
7 34.04 12.9 
8 33.87 -2.9 
9 52.3 17.09 
10 45.1 23.77 
11 45.45 4.12 
6 5 
7 34.22 2.63 
8 33.17 -13.07 
9 48.44 -15.93 
10 44.83 -2.81 
11 45.36 -22.49 
7 5 
7 33.17 13.07 
8 34.22 -2.63 
9 48.44 15.93 
10 45.36 22.49 
11 44.83 2.81 
17 5 
7 35.18 7.11 
8 35.36 -8.51 
9 49.09 -9.25 
10 45.01 -1.58 
11 45.36 -14.14 
18 5 
7 35.36 8.51 

8 35.18 -7.11 
9 49.09 9.25 
10 45.36 14.14 
11 45.01 1.58 
27 5 
7 31.15 9.83 
8 30.97 -12.9 
9 39.19 -5.65 
10 44.85 0.9 
11 44.33 -12.85 
28 5 
7 30.97 12.9 
8 31.15 -9.83 
9 39.19 5.65 
10 44.33 12.85 
11 44.85 -0.9 
8 5 
7 32.9 9.04 
8 33.17 -10.44 
9 42.79 0 
10 45.75 5.78 
11 46.39 -6.94 
20 4 
7 31.41 6.32 
8 31.32 -13.69 
9 42.66 -5.53 
10 44.72 1.29 
21 4 
7 31.32 13.69 
8 31.41 -6.32 
9 42.66 5.53 
11 44.72 -1.29 
24 5 
7 31.5 8.16 
8 31.06 -13.16 
9 46.77 -6.55 
10 44.92 0.18 
11 45.62 -16.76 
25 5 
7 31.06 13.16 
8 31.5 -8.16 
9 46.77 6.55 
10 45.62 16.76 
11 44.92 -0.18 
Player 10 12 
1 5 
7 34.57 23.25 
8 34.13 0.79 
9 46.68 15.35 
10 54.49 36 
11 44.2 1.67 
49 2 
10 19.79 28.66 
11 29.68 -13.49 
18 5 
7 33.6 12.55 
8 34.22 -4.74 
9 46.9 5.27 
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10 49.22 9.25 
11 45.36 -2.7 
7 4 
8 36.37 3.73 
9 48.34 7.28 
10 48.57 15.81 
11 45.01 0 
40 4 
8 24.65 2.02 
9 38.42 17.35 
10 29.17 34.18 
11 39.06 -2.18 
42 5 
7 20.79 26.41 
8 24.65 -3.25 
9 39.19 15.81 
10 33.02 31.1 
11 40.09 -0.9 
30 5 
7 20.18 19.48 
8 22.72 -7.11 
9 40.99 9.64 
10 30.2 15.93 
11 38.16 -1.29 
5 5 
7 26.67 16.93 
8 29.48 -7.19 
9 42.64 6.67 
10 36.62 11.95 
11 42.73 -3.6 
14 6 
6 18.86 5.44 
7 32.64 15.09 
8 34.39 -1.14 
9 44.66 11.14 
10 52.43 16.96 
11 45.89 0.61 
34 5 
7 27.64 17.81 
8 34.04 2.54 
9 44.92 11.93 
10 44.59 22.36 
11 44.92 0.88 
36 5 
7 27.63 22.62 
8 32.2 4.47 
9 43.17 15 
10 38.55 26.21 
11 43.05 1.93 
38 5 
7 25.88 22.99 
8 32.81 5.97 
9 44.13 15.88 
10 43.95 29.56 
11 44.22 0.53 
Playe 
r 11 12 
0 5 

7 34.13 -0.79 
8 34.57 -23.25 
9 46.68 -15.35 
10 44.2 -1.67 
11 54.49 -36 
48 2 
10 29.68 13.49 
11 19.79 -28.66 
17 5 
7 34.22 4.74 
8 33.6 -12.55 
9 46.9 -5.27 
10 45.36 2.7 
11 49.22 -9.25 
6 4 
7 36.37 -3.73 
9 48.34 -7.28 
10 45.01 -0 
11 48.57 -15.81 
39 4 
7 24.65 -2.02 
9 38.42 -17.35 
10 39.06 2.18 
11 29.17 -34.18 
41 5 
7 24.65 3.25 
8 20.79 -26.41 
9 39.19 -15.81 
10 40.09 0.9 
11 33.02 -31.1 
29 5 
7 22.72 7.11 
8 20.18 -19.48 
9 40.99 -9.64 
10 38.16 1.29 
11 30.2 -15.93 
4 5 
7 29.48 7.19 
8 26.67 -16.93 
9 42.64 -6.67 
10 42.73 3.6 
11 36.62 -11.95 
13 6 
6 18.86 -5.44 
7 34.39 1.14 
8 32.64 -15.09 
9 44.66 -11.14 
10 45.89 -0.61 
11 52.43 -16.96 
33 5 
7 34.04 -2.54 
8 27.64 -17.81 
9 44.92 -11.93 
10 44.92 -0.88 
11 44.59 -22.36 
37 5 
7 32.2 -4.47 
8 27.63 -22.62 

9 43.17 -15 
10 43.05 -1.93 
11 38.55 -26.21 
35 5 
7 32.81 -5.97 
8 25.88 -22.99 
9 44.13 -15.88 
10 44.22 -0.53 
11 43.95 -29.56 
End Player With Ball 
Samples 
End 
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Appendix C: Flux 

Begin Flux 119 
0 0.56 9.51 42  
1 0.56 -9.51 42  
2 0 0 42  
3 54.5 36 50  
4 -54.5 36 18  
5 0.3 36 45  
6 28.17 36 55  
7 28.17 0 55  
8 54.5 0 100  
9 40.59 0 90  
10 -39.98 36 25  
11 -39.98 -19.84 18  
12 -54.5 0 0  
13 -46.65 0 5  
14 -54.5 20.14 10  
15 -46.5 -19.99 16  
16 -46.95 36 21  
17 -46.95 -36 21  
18 -46.5 19.99 16  
19 -54.5 -20.14 10  
20 -39.98 19.84 18  
21 -39.98 -36 25  
22 -26.35 36 36  
23 -26.35 -19.54 33  
24 -26.35 19.54 33  
25 -51.44 0 0  
26 -26.2 0 29  
27 -40.44 0 10  
28 -12.87 -36 40  
29 -12.57 0 35  
30 0.84 27.96 45  
31 14.96 -27.54 50  
32 28.1 28.52 55  
33 40.54 -27.96 65  
34 47.39 28.1 60  
35 54.5 -28.1 60  
36 54.5 28.1 60  
37 47.39 -28.1 60  
38 40.54 27.96 65  
39 28.1 -28.52 55  

40 14.96 27.54 50  
41 0.84 -27.96 45  
42 1.06 18.33 45  
43 1.06 -18.33 45  
44 -12.87 36 40  
45 -12.87 -17.87 38  
46 14.69 0 48  
47 15.15 36 50  
48 35.09 0 75  
49 34.53 -9.23 70  
50 34.53 18.03 65  
51 34.67 -28.24 60  
52 35.09 36 55  
53 35.09 -36 55  
54 34.67 28.24 60  
55 34.53 -18.03 65  
56 34.53 9.23 70  
57 15.15 -36 50  
58 14.69 18.02 50  
59 28.02 -18.17 55  
60 54.5 8.81 85  
61 47.81 -9.09 90  
62 40.96 9.23 85  
63 28.24 -9.23 55  
64 14.82 9.37 48  
65 -12.72 -9.51 36  
66 -26 9.23 31  
67 -40.12 -9.78 13  
68 -46.13 10.2 8  
69 -54.5 -9.78 7  
70 -54.5 9.78 7  
71 -46.13 -10.2 8  
72 -40.12 9.78 13  
73 -26 -9.23 31  
74 -12.72 9.51 36  
75 14.82 -9.37 48  
76 28.24 9.23 55  
77 51.86 0 100  
78 40.96 -9.23 85  
79 47.81 9.09 90  
80 54.5 -8.81 85  

81 54.5 18.33 67  
82 47.56 0 100  
83 47.41 -17.42 70  
84 47.86 36 55  
85 47.86 -36 55  
86 47.41 17.42 70  
87 54.5 -18.33 67  
88 40.74 17.87 70  
89 40.14 -36 55  
90 40.14 36 55  
91 40.74 -17.87 70  
92 28.02 18.17 55  
93 14.69 -18.02 50  
94 -13 28.1 40  
95 -26.42 -27.82 35  
96 -39.7 28.1 20  
97 -46.69 -27.68 20  
98 -54.5 28.1 16  
99 -54.5 -28.1 16  
100 -46.69 27.68 20  
101 -34.67 0 25  
102 -33.83 -9.37 25  
103 -33.69 19.43 27  
104 -33.97 -27.68 30  
105 -33.97 36 31  
106 -33.97 -36 31  
107 -33.97 27.68 30  
108 -33.69 -19.43 27  
109 -33.83 9.37 25  
110 -39.7 -28.1 20  
111 -26.42 27.82 35  
112 -13 -28.1 40  
113 -12.87 17.87 38  
114 -26.35 -36 36  
115 28.17 -36 55  
116 0.3 -36 45  
117 -54.5 -36 18  
118 54.5 -36 50  
End 

 


